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GTrek Help Files 

1. Welcome 

Getting acquainted with your 
GTrek 

Your GTrek comes to you ready to use but before you do it is 
advisable to read the following.  

Your GTrek is simple to use but there are a few minor points which 
you should be aware of when using it to ensure accurate data is 
available for maps and routes to be produced. 

1. Your GTrek data logger receives data from orbiting 
satellites and converts the meaningless data streams into 
useful information. It then saves this data until it is transferred from the device into the GTrek 
program where meaningful information is produced.  

2. On the left hand side there is a three position switch, the functions are as follows:-  
1. OFF - In this position the unit is in the off position, no data will be collected in this 

state.  
2. NAV (GTrek II)  

In this position the blue Bluetooth light will illuminate and an attempt will be made to 
communicate and connect with another Bluetooth device. If such a device is found 
and can be paired with GTrek it will assume the roll of a slave device supplying data, 
the Bluetooth light will also flash. In this position GTrek can be used as a data source 
for third party programs such as TomTom or Google Maps for Mobiles etc. and can 
function as a GPS receiver for a satellite navigation systems. If after about 60 
seconds GTrek is not paired with another device then the Bluetooth communications 
will be shut down to conserve battery power. Data logging will also cease, the 
Bluetooth light will start to flash very slowly. It will however wakeup if a Bluetooth can 
be connect with at a later time, in this sleep mode the battery will remain active for 
approximately 350 hours.  
Note: If a device ID code is requested when pairing GTrek then use 0000 (4 zeros)  
CAR (GTrek III) 
In this position the GTrek logs data only when power is applied to the USB port. The 
process here is that if used in a vehicle logging only occurs when the car ignition is 
switch on, when off logging stops automatically. 

3. LOG/Smart - This is the normal position and when switched to this position the data 
log will automatically start recording data at the preset rate until switched off as long 
as an active satellite lock is obtainable. Bluetooth communications will also function in 
this position and provide services as detailed in (2) above but will not shut down if the 
Bluetooth is subsequent disconnected.  

3. On the top surface of the device you will find three lights and a push button  
1. The satellite fix light is multi-function and multi-colour (amber and red)   

1. An amber light on - satellite fix not obtained and no data is not being 
collected  

2. An amber light flashing - satellite fix obtained and useful data is being 
collected.  

3. A red and amber light on - data not being collected, internal memory is full 
and has stopped logging and needs to be downloaded and then cleared.  
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4. A red light off - normal operation condition.  
5. A red light flashing slowly - internal memory is more than 90% full and needs 

to be downloaded as soon as possible.  
6. A red light on - see 3 above.   

2. The green power light  
1. A green light on - this is a charging indication  
2. A green light off - the unit is fully charged, this light may flicker when 

fully charged if downloading data   
3. A red light on if the battery power level is very low. In this situation the battery 

should be recharged without delay.  
3. The blue Bluetooth light (GTrek II only) 

1. A blue light off - Bluetooth is disabled or is not paired  
2. A blue light on - GTrek has not yet paired with a Bluetooth device  
3. A blue light flashing - GTrek is connected and ready to transfer data  
4. A blue light flashing slowly - No Bluetooth connection, GTrek has entered a 

low power sleep mode.  
4. The blue “S” light (GTrek III only) 

1. When in the CAR mode this blue LED with flash to indicate that the 
GTrek is in a low power sleep mode waiting for power to be re-
applied. 

5. The push button  
1. This button when pushed will log additional data points and the amber 

Satellite light will flash amber and red three times. Routes when viewed by 
the data analyzer will add small blue circles indicating where on the route the 
button was pressed. Routes viewed in Google Earth will have location 
markers positioned at locations where the button was pressed along with 
additional information. This button can be used as often as required   

4. On the right is a mini USB socket used for transferring data and for charging the battery.  

Note 
When your GTrek is first switched on it will need to establish its bearings and calculate its location. If 
the location is close to where it was when it was switch off then a warm start up sequence will be 
initiated. 

If the new location is some distance from the last one then a cold start is initiated as any information it 
has acquired will not match data it is receiving now. This requires more data to be downloaded and 
can take a little longer to obtain a 3D fix. During this time your GTrek may not communicate with 
the GTrek program. If this is the case position your GTrek where it can be seen by the satellites and 
try again after a couple of minutes. If the satellite light starts to flash then a satellite fix has been 
obtained and you are ready to go. In this situation it is more difficult to obtain a satellite lock if the 
device is moving ie. in a car and may take longer to get the information required. The number of 
satellites in view also has a bearing. 

Alternatively use the “Update AGPS” utility in the “Settings” menu to jump start the data acquisition 
phase. Using this utility a time to first fix (TTFF) can be as low as 15 seconds. 

Bluetooth pairing with your smart phone is an easy process, switch on the GTrek (NAV or LOG) and 
follow the instructions provided with your hand held device. Your GTrek identification is “iBT A+ GPS”. 

If a pass key is requested when pairing your GTrek with a Bluetooth device use 0000 (4 zeros). 

Important 
Clearing down your GTreks' memory after data has been downloaded or re-configuring your GTrek 
after a change in the logging settings imposes a larger drain on the power supplied by the battery for 
a short period. It has been noticed that in a very few cases where the GTrek battery charge is very 
low and where the connect PC USB port is configured for a low power device that the GTrek internal 
memory is not initialized correctly. In the worst case scenario the GTrek will be rendered inoperative 
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and will require it to be returned to the factory for a repair to be implemented. It is therefore 
recommended that the GTrek memory is not cleared or re-initialised when the battery is known to be 
in a very low state of charge or after an extended time of non-use, allow the battery to charge for 
about 10 to 15 minutes first. 
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1.1 Notes and Warnings 

1. GTrek uses a Lithium-ion battery. If your GTrek is used in temperatures lower than -10ºC or 
higher than 60ºC its battery charge capability will decrease. A pocket is a good place as body 
heat will maintain temperature. Please keep your GTrek data logger away from particularly 
low or high temperature environments. In addition, do not expose your GTrek data logger to 
temperatures higher than 140ºF/60ºC. If you do not follow these rules the battery 
inside your GTrek may overheat, explode or ignite, and this will lead to serious damage. The 
Lithium-ion battery inside the GTrek should be recycled in a proper way and should never be 
thrown into normal refuse or disposed of in an incinerator. 

2. Your GTrek should not be used in prohibited locations such as on-board airplanes and 
in hospitals so turning off your GTrek is recommended. Wireless GPS receivers and 
BlueTooth communications may interfere with sensitive equipment which use radio frequency. 

3. If your GTrek data logger is not to be used for long periods it is recommended that the 
battery be removed and stored separately in a dry and cool place. Re-charging periodically is 
also recommended (by periodically we mean recharge your battery every two to three 
months). 

4. For safety keep your GTrek and all accessories out of children's reach. The GTrek system is 
a useful tool and is not a toy, though we do hope you have a lot of fun with it. 

5. The manufacturer of GTrek and related products assumes no responsibility for any 
damage or loss resulting from the use of this manual, or from deletion of data as a result of 
malfunction, dead battery, or from misuse or use of the product in any way. 

6. Use only the supplied and approved accessories. Unauthorized accessories, modifications or 
attachments could damage your GTrek and may violate regulations governing radio devices. 

7. None of the above detract from your statutory rights under European law, however if you have 
a problem please call us first. 

1.2 Software Installation 

PLEASE READ THIS SECTION FIRST  

Install Software Prior to Connecting GTrek 

Refer to the installation sheet provided with you GTrek or the installation guides in the Manuals folder 
on the CD as these cover all Microsoft Windows version and may be more upto date than the 
information here. 

Prior to connecting your GTrek to your PC you are required to install the application software and 
device drivers. However it's quite acceptable to connect your GTrek without switching it on just to 
charge the battery. If your GTrek is switched on and connected then Microsoft Windows will attempt 
to load appropriate drivers. Without the correct software pre-installed your GTrek may be installed 
incorrectly. Undoing this is possible but not within the scope of this manual. 

The installation instructions that follow assume your operating system platform is Windows XP with at 
least Service Pack 2. This is considered the minimum. For Vista or Windows 7 please refer to 
additional installation instructions provided on the installations disk. 

The installation is a simple automated process which should take just a couple of minutes. The 
application requires that Google Earth be installed prior to the main installation, if it is not found the 
user is automatically referred to Googles website to download and install a copy. A connection to the 
internet is required for this process.  

Google can be installed at any time prior to the application installation by going to 
http://earth.google.com  and clicking the button labeled "Download Google Earth 5.0" and following 
the instructions provided. 
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At the end of the installation of the application GTrek device drivers are installed this 
needs to be accepted before the process completes. If nothing changes for any length 
of time then check for dialogue boxes that may be covered. Look for this icon on the 
task bar 

The installation should proceed as follows.  

1. After inserting the installation disk into your CD-
ROM drive the installation program should run 
automatically. If not, open "My Computer" and 
double click startUp.exe on the installation CD. 
If "The publisher could not be verified" 
message appears select Run . The Welcome 
box will be displayed, Click next. 
 
 
 
 
 
 

2. Google Earth is a required component for the 
GTrek application, If already installed this step 
will be skipped. If not found this dialog box will 
be displayed. Clicking Yes will open the Google 
Earth webpage where the "Download Google 
Earth" button should be clicked. A connection to 
the internet is required. Follow the instructions 
provided. Once complete restart the installation 
procedure. 

3. The GTrek program requires a Microsoft system 
extension called ".Net Framework 2.0" and needs to 
be installed next. Click Accept and the installation will 
proceed. ”.Net” may already be installed, if so this 
step will be skipped. If required this may take a couple 
of minutes to complete.     
 
 
 
 
 
 
 
 
 
 

4. The Welcome Screen is now displayed. Click Next to 
continue. 
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5. The GTrek End User License Agreement is displayed 
next and the user needs to click I Agree and Next to continue. 
You should actually read it, but we can't make you. 
 
 
 
 
 
 
 
 
 
 

 
   

6. GTrek is normally installed in the default folder. It can be 
changed if necessary, although the default folder is 
recommended.  
Microsoft Windows XP and Vista provide support for more 
than one user; this program can be installed for a single 
user (default) or can be accessed by all users. This 
selection can also be made here. Click Next to continue. 
 
 
 
Confirm installation, Click Next to continue. The installation 
stage normally takes less than a minute. 
 
 
 
 
 
 
 

7. If the Windows Logo Testing message is displayed click 
Continue Anyway. This is a Windows security message and 
is not always automatically displayed. It is also not always 
displayed above all other items currently being displayed and 
hence the installation process may appear to hang. At no 
time during the installation process should there be any 
length of time where no update process is being displayed.  

8. GTrek will now commence the installation. When the 
installation has finished click Close to complete the task. 
That concludes the installation and the CD can be 
removed.    
 
 

9. Insert the battery into Your GTrek data logger aligning 
the battery terminals with the contacts, replace the 
cover and connect your GTrek to the PC with the mini 
USB cable supplied and set the power switch to the 
LOG position. 
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A message will be displayed stating that New Hardware 
has been detected and the Hardware Wizard will be 
launched.  
A Dialog box will be displayed requesting directions to 
install the new hardware, click Yes, this time only and 
Next and Next again . 
  

10. The installation process will start by searching for the 
information required. When found the drivers will be 
installed. Click Finish to complete the process. 
 

11. An information balloon will be displayed indicating that 
the process has completed without errors. 

  

It is recommended that prior to first use, your GTrek data logger should be configured and initialized. 
Switch on your GTrek and launch the GTrek application by double clicking the icon that is now on 
your desktop, if you have a connection to the internet then select Settings->Update AGPS and pre-
load the satellite data. Allow it to synchronize with the satellites. From the Settings menu select 
Configure GTrek, select the desired data logging rate and click Save . Your GTrek will be configured 
for use and the on-board memory will be cleared. 

The battery should be fully charged before use. The green light being switched off indicates the 
charging process is complete. Your GTrek is now ready to go. Use your GTrek and get familiar with it. 

 Don't forget to register your GTrek system, if you do, we will notify you when there are updates 
available. 

1.4 Installation Configuration 

After the software installation has completed the default configuration can 
be setup here. Select the icon(s) which are to be placed on the desktop. 
You can select any of the GTrek flavours Ski, Bike or Track in any 
combination. You don’t have to select any if you don’t want to clutter up 
your desktop. 
 
Next enable the program Hot-Key if required and select the key 
combination, the default is Ctrl+G.  
 
Next click the "Create Desktop Icon" for the GTrek-GeoTagger if a 
desktop Icon is required for this utility.  
 
After the installation is completed all 4 versions of the GTrek programs 
along with the user manual can be accessed from the Start->All Programs->GTrek menu.  
 
No matter which program is used to download the data from your GTrek it is compatible with all the 
others. 

1.5 GTrek Device Driver Installation 

Once the main software has been installed and configured the GTrek device drivers, that allow the 
operating system (XP, Vista or Windows 7 etc) to communicate with the GTrek Data Logger, have to 
be installed and configured.  
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Remove the GTrek from it's packaging and remove the battery cover, insert 
the battery lining up the  battery terminals and replace the cover. Connect 
the GTrek Data Logger to your PC with the supplied USB data cable and 
the green charging indicator will illuminate. Slide the power switch to the 
LOG position and the yellow satellite indicator will illuminate. This indicates 
that the GTrek is on and no satellites have yet been detected, when later a 
satellite lock has been established this indicator starts to flash. If indoors 
the building may shield the satellite signals. 

This process only needs to be done once. 

If you wish to perform this process later click the "Cancel" button. This "driver Installation" procedure 
will proceed without the GTrek program running and will be done the first time the GTrek Data Logger 
is connected automatically. 

We have had a small number of instances where the device drivers have not been installed correctly 
on the first try. If you receive a message that indicates this then switch off the GTrek and after a few 
seconds switch it on again. If the message is displayed again please get in touch through the website 
www.gtrek.co.uk either by email or phone (UK office hours). 

An information bubble should be displayed indicating that a new USB 
device has been detected and  that the device drivers are being 
installed. If installing on Windows XP a dialogue box will appear, select 
"Yes, this time only" and in the next box select the recommended 
option. 

Once the process has been completed a message is displayed. Click 
OK and the process will finish. 

Slide the power switch to the off position and leave it connected until the green indicator turns off to 
indicate the battery is fully charged. 

If your GTrek is not used for extended periods we recommend that the battery is removed and stored 
in a cool dry location (don't forget where you put it). It should be recharged at least once every 4 
months. 

Additional or replacement hi-capacity batteries are available from GTrek Ltd. The battery is similar to 
a standard Nokia Phone battery and these can be used but they have only about half the power of the 
original and will only give about 12 hours of use. 
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1.6 How to use your GTrek 

Your GTrek has been designed to provide ease of use from the start to getting the results. However 
some simple preparation is always of use and some simple tips are included here  

1. Charge your battery. There are some additional notes . Your GTrek data logger can be 
charged in any one of three ways as follows:-  

1. From the mains supply with the optional supplied charger. This charger is dual 
voltage, 50 or 60hz and will work anywhere with a suitable adaptor. Do not use a 
charger from another device as this may damage your GTrek. Inspect the charger 
before use and do not use it if it looks damaged. Replacements can be obtained from 
the web site www.gtrek.co.uk.  

2. Your GTrek can be charged by plugging it into a car power socket with the supplied 
charging cable, again use nothing other than the supplied charger as damage may 
result.   

3. Through a connection to a laptop or desktop PC by the USB cable. Your GTrek is 
supplied with a standard mini-USB cable which is used to transfer data between 
your GTrek and a computer. It also re-charges the battery when connected to the PC. 

2. At the start of your day's activities switch your GTrek on. If it's not switched on it won't record 
anything, however it's never too late. On the side of your GTrek there is a three position 
switch labelled OFF-NAV-LOG, be sure to switch it to the LOG position. From cold it can take 
from a few tens of seconds to a few minutes to get a satellite fix, it depends on the number of 
satellites in view. If you are inside a car or bus it may never get a fix at all, moving at high 
speed also does not help. A fix is indicated by the satellite light (yellow) blinking. Once a fix is 
obtained it's a lot easier to maintain synchronization. Place your GTrek in a pocket or pack 
where it can get a good unimpeded view of the sky. Covering it with a tin box for instance is 
not a good idea.  

3. When your days activities finish switch your GTrek data logger off otherwise you may collect 
unwanted data and waste battery energy.  

4. On return to your residence download the data and save it and/or e-mail it to yourself at home 
and analyse the results.  

5. Clear down the memory ready for the next day (don't forget item 1 above)!  
6. Once data has been downloaded the Analysis screen is automatically loaded. View your 

route, distances and speeds, view the profile. Select the Google Earth Tour button to replay 
the route or load Google Earth and view your route in 3D. 

Special Note 
If the Data Analysis screen is closed without saving new or modified data the user is prompted to 
save that data. If it's still not been saved however or the application terminates unexpectedly then that 
data can be retrieved manually. Once the data download has been completed a copy of the data is 
temporarily saved to the default location (normally MyDocuments\Ski-Log Data Files) with the name 
Auto-Save.gbf. Copy and paste this file and rename it for your use. 
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1.7 What's New 

Ski-Log was originally designed as a device for skiers and boarders alike but we could see 
applications for other sporting and outdoor leisure activities and we were going to end up with a 
number of slightly different devices with different names. So GTrek has been created, this allows us to 
create GTrek - Ski, GTrek - Bike GTrek - Track and other applications we are working on. Watch the 
website for new products. It doesn't matter which version you purchase as each version contains the 
other two, only the desktop icon is different. 

If you have registered your GTrek then we will inform you when updates and downloads are available. 
You will also be notified automatically when new updates are available. 

So what's really new for version 2 ? 

We have added many new features and improved the way the program is used, some of the new 
items are as follows:- 

1. Export not only to Google Earth™ but to Google Maps™ and export files for MemoryMap, 
data exported to Google Maps can also be imported into Google Maps for Mobiles.   

2. Double click on a .GBF or .GSF file and GTrek will run and load the file automatically  
3. The "Configure GTrek" facility now has 3 options giving you the option of :-  

1. 1 second update with storage for 16 hours  
2. 4 second update with 60 hours of storage  
3. 6 second update with over 100 hours of storage 

4. The Analysis screen now has a tab page format providing easy access to the Route Display, 
Altitude Display and Speed Display.  

5. The Route display has a North pointing compass and the display is rotatable, it has an 
overlaid grid with a measured scale  

6. The Altitude and Speed displays have height or speed and Time scales  
7. All three screens can have Point Of Interest labels inserted. A POI inserted on the Route 

screen also displays on the other screens as well.  
8. A "Trip Details" facility has been added to allow additional information to be save with the 

.GBF file to provide a reminder of the trip or journey.  
9. A profile page has been added showing height and speed on the same graph. This page also 

displays data entered on the Trip Details. POI data can also be displayed.  
10. The "Route Summary" has been extended to include Up, Down and Level distance data along 

with average ski (travelling down) speed.  
11. A Quick Statistics page has been added to allow for a comparison between several days 

activities.  
12. A facility to quickly remove POI's and My Place markers.  
13. A facility to import Points Of Interest (POI’s) into a file from another  
14. A Quick Statistics page has been added to allow for a comparison between several days 

activities.  
15. A facility to remove erroneous data in the middle of a data stream.  
16. The time information stored by the GTrek is always in UTC (the same as GMT). Data 

recorded can come from any time zone which can be corrected for when it's downloaded. A 
facility has been included to correct any time errors after it has been downloaded.  

17. Additional functionality to support GTrek-Bike including an ability to display the Altitude and 
Speed displays by distance. 

So what's new for version 3 ? 

1. Automatic update notification when new versions become available.  
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2. Support for exporting Google Earth/Maps files in ZIP'ed format making them very much 
smaller.  

3. Changes to the data download algorithm to make the process more immune to missing data. 
A problem that may occur on older and slower PC's  

4. Provision for a selectable 'Y' axis on the Altitude display  
5. Modifications to the Profile page to allow either of the two graphs Altitude and Speed to be 

independently switch off and a fill facility. Go take a look you'll get the idea.  
6. In Google Earth 4.1 the process of running the tours to create a virtual fly through were 

changed. To accommodate this the export process now provides two options:-  
1. If the data gathered was on the ground ie. skiing or biking then select the Track on 

Ground option.  
2. If the data gathered was in the air then select the Track not on ground option. 

7. In the original version only a single analysis screen could be displayed, now many screens 
can be opened simultaneously.  

8. In the Position screen where the visible satellites can be viewed a satellite trail feature has 
been added so the satellite paths can be seen. Beware this is a bit like watching paint dry.  

9. The standard data logging intervals of 1, 4 and 6 seconds has been extended to log every 
200m/s thus providing an update 5 time a second for application where speed is of an issue.  

10. A fully featured digital picture GeoTagging facility has been added. Users track their routes 
and take pictures for much the same reasons, to provide a record of where there have been 
and what they have seen. It therefore makes sense to combine these two technologies. The 
GeoTagging features download and save the GTrek routes, Download your digital pictures 
from your camera and merge the two into a single file that not only show's your pictures but 
tells you when the picture was taken and where you were when you took the picture. The 
resulting file can be loaded into Google Earth so it can be shared with friend and family. 

Version 3.2 

1. Added Export to .CSV file format 

Version 3.3 

1. Minor bug fixes to the Analyse screen and Trim function  
2. Corrections for globalization errors (ie '.' instead of ',' in numbers)  
3. Bug fix in GTrek device detection logic.  
4. Bug fix in lift and hill count logic  
5. Remove "Exit GTrek, are you sure"  
6. Tab order in Trip details changed  
7. Changes to Download screen  
8. Added Save File Name on Quick Statistics screen 

Version 3.4 

1. Driver installation process changed.  
2. AGPS download system added to improve time to first fix (TTFF)  
3. Added globe image on Position screen 

So what's new for version 4 ? 

Well version 4 brings a complete makeover and the release of GTrek-Track a completely new 
application based on the GTrek-Bike version. GTrek-Track brings multi-route displays and 
calculated G force displays on the speed screen. 

1. Creation of GTrek-Track  
2. Multiple route file display  
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3. Calculated G force on speed display 

Version 4.1 

1. Minor bug fixes 

Version 4.2 

1. A change in the way Time Zones are handled to make it easier to synchronize your camera 
time with the downloaded data time used to GeoTag digital pictures 

Version 4.4 

1. Correction to the Rotate function when displaying downloaded routes  
2. Improved panning function on the route display with mouse click and drag.  
3. Increased accuracy on the Lap extraction utility. Lap times are now calculated to 0.001 

seconds 

Version 4.5 

1. Fix an error in the track data calculation of lap times.  
2. Added Right-Click function in Route Summary box to copy contents to the Clipboard  
3. Single Click to start download of data from GTrek when switch on  
4. When exporting data to Google Earth when in GTrek-Track the default Smoothing value 

defaults to 1 and 4 in GTrek-Bike and GTrek-Ski  
5. When the Trim sliders are selected on the Trim-Data page selection indicators are displayed 

Version 4.6 

1. A new facility in the View menu on the Analyse screen "Trace Data Selection" to 
select/deselect traces in a multi trace view and select the default trace.  

2. A new facility in the Settings menu on the Analyse screen "Delete Inactive Data" to 
automatically identify and remove and data deemed to be inactive. 

Version 4.8 

1. Error in track colour when exporting multiple tracks to Google Earth.  
2. A "Most Recent File" listing added to the File menu on the mail screen  
3. A simplified multi-track selection utility added in the Analysis screen of the GTrek-Track 

program.  
4. An error was found in the vertical assent and decent calculation, this has been fixed.  
5. The Longitudinal G force calculation has been altered with the addition of a thumb wheel to 

select the sample rate.  
6. The "Configure GTrek" screen now has additional control features. Logging is no longer 

restricted to 4 set time periods and can now be set from 0.2s to 99.9s and a new feature to 
log by distance and speed.  

7. With logging rates that not exactly one second apart require additional time data.  
8. The data download time has been reduced from 12 minutes for a full GTrek to about 60 

seconds (PC dependant).  
9. GTrek is now fully Windows 7 compliant. 
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So what's new for version 5 ? 

Version 5 has had a complete makeover, the main areas affected are anywhere that GTrek interacts 
with Google Earth. Google Earth as a Google product has been much improved lately and this version 
exploits these changes to the full. 

Most Google Earth users view GE as a means to view images of the ground taken from NASA 
satellites, few comprehend that just under the surface of the program there is whole programming 
language that can be exploited to provide a rich content and to enable imagery and functionality not 
previously available. 

GTrek prior to Version 5 was capable of providing Google Earth tours but required GE to be selected 
and manipulated. These tours were played out at a constant speed no matter what the route data 
called for. Now in version 5 tours are easy, they run at real time speed and include realistic models 
that follow the recorded route exactly either on the ground or in the air. 

The program has gone through beta testing and the initial release if V5.0.11. 

Version 5.0.11 

1. The main Analyse screen loaded when download completes now has a fourth page which 
displays the route, altitude, speed and essential statistical data together. 

2. There are now two Google Earth button on the data Analyse screen, the standard Google 
Earth button and a new Google Earth Tour button. 

3. The digital picture GeoTagging screen has been re-written to use the updated of Google 
Earth. 

4. Addition of the Google Earth screen where the terrain and imagery can be controlled, where 
models can be loaded and snap shots of the view can be taken and saved. 

5. Changes to the Position screen now show the signal strength of the satellites in view. 

Version 5.1 has had some significant updates and some minor bug fixes as follows:- 

1. Changes to the Tilt, Rotate and Scale functions in the Google Tour to allow greater resolution 
and control. 

2. Additional models added to the Google Tour screen 
3. Updates associated with Google Earth API version 6 
4. There was a problem during the installation procedure where the GTrek device driver 

installation completion screen could get lost behind other screens giving the impression that 
the installation process had stopped. This screen is now independent of the rest of the 
installation process. 

5. Fix minor bug in the Speed Bars display. 
6. Additional functions added to the Statistics display screen:- 

1. New data for the Ski/Bike/Track applicable to the versions 
2. If files that have been added to the Quick Statistics are subsequently changed you 

will be prompted to update the display with the new data. Only applied to data added 
on or after Version 5.1.0. 

3. Option to set the distance data resolution to 1 to 4 decimal places. 
7. Changes in the way altitude changes are detected to make the system more responsive and 

to add a blue line colour to indicate no or minimal altitude change on the Google Tour screen. 
8. Changes to the Configure GTrek screen to allow the selection of the maximum logging rate to 

be set to 5hz or 1hz 
9. Ability to export Google Earth data in either KML (normal data) or KMZ (compressed) file 

format. 
10. When data is downloaded the user is prompted to automatically set the time zone for the data 

to that set on the PC. 
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11. The GTrek Track utility (available only in the GTrek-Track version) has the ability to set a 
Start and/or Stop line for the extraction of the lap data. These lines are normally set 
perpendicular the track data but can now be rotated independently. 

12. Fix bug in Analyser screen where the animation marks don't always get cleared correctly. 

Version 5.1.1 Changes mainly to the Geo-Tagging utility 

1. Corrected problem where no route would be displayed if the number of records or data points 
exceeded 32,000 

2. Thumbnail pictures adjusted for landscape and portrait and for picture aspect ratios that are 
not standard 4:3 

3. Changed the Set Camera Time screen to make it easier to use, 
4. Changed the Geo-Tagging utility to cater for off-line support 

Version 5.1.2 Minor bug fixes 

Version 5.1.4 Enhancements to the Geo-Tagger utility 

1. Added ability to add textural information to geo-tagged images which is displayed when the 
data is exported to Google Earth 

2. Corrected screen display to cater for the display zoom option on Windows 7 

Version 5.2 Major enhancements to the Geo-Tagger utility 

1. Changes to cater for additional file types to include not only .JPG but .BMP, Canon file types 
.CR2 and Nikon File types .NEF and several common other file types. 

2. Included the new GTrek-Image Viewer utility, this is a separate program designed to view 
images, geo-Tag data and to provide slide shows. It's compatible with all the major image file 
type available today. 

3. Added functionality for “All User” installation option 
4. Added a Search function to find locations in the GeoTagg page in the GTrek program and a 

similar utility in the GTrek-IV image viewer. 
5. Added “Device Serial Number” to statistical data screen 
6. Added a utility to upload route files to the GTrek web servers that can be view an PC’s, 

MAC’s and many smart devices 

Version 5.3.0 Minor updates and additional features 

1. Additional facility to import .GPX file from the main screen 
2. When moving from one image to the next in the GeoTagger the view angle and range are 

now maintained. 
3. Error in GeoTagger when tagging images from multiple routes 
4. GeoTagger not updating all layers in Google Earth 
5. Right-click menu in data summary on main screen fixed. 
6. GTrek option selection screen added to make the installation program universal 
7. Install GTrek device driver now part of the installation process 

Version 5.3.2 Minor updates and additions 

1. Historical image view added to Google Tour display 
2. Changed to the Delete Segment screen to speed up the process 
3. Changes to the Analyse screen to display total duration and time spent going Down, Up and 

Flat. 
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Version 5.3.9 Minor updates and additions 

1. Right click menu on summary now able to copy to the clipboard data in .CSV format 
2. Export data formats extended to Flight format files types of .GPX data as Waypoints and IGC 

format 
3. Additions to Quick Stats:- 

a) New columns for Down/Up/Flat times 
b) New columns for User designated data (see below) 
c) Support for Miles and Km 
d) Export data in .CSV format 
e) Option to reset columns to default order 
f) Most Resent Used files facility added to File menu 
g) Quick Stats when opened automatically opens most resent Stats file 
h) File menu Save and SaveAs 

4. Trip Details screen now has upto four selectable additional titles and data fields that can be 
saved and restored. This data impacts the Data Summary, Profile and Quick Stats screens 

5. Extensive re-write of the Profile screen which is now much faster. 
6. Profile screen now has a slideable transparency function to allow the back image to show 

through the trip data. 
7. Profile option facility to allow user to select which data is displayed as statistical data in the 

top boxes. 
8. Data can now be added to Quick Stats data base from the Analyse Screen 

Version 5.3.13 Minor bug fixes and changed to presentation 

1. Fix in GeoTagger for non-JPG images 
2. Error in uploading KMZ files where the file name exists. 
3. Error in the GeoTagger Sync-Time utility due to changes in US Navy time-port website 
4. Error in Delete Inactive Data utility, delete button was missing. 

Version 5.3.23 Minor bug fixes and changes to the main analyser screen and printable images 

1. Addition of Date/Time on Google Tour screen 
2. Changes to the Uninstall procedure to remove all traces of the program but leave saved 

routes intact 
3. Bug fix on the Speed and Altitude screens where the X axis displayed data tended to 

overwrite adjacent labels 
4. Changed to the data displayed in the first Analyser screen to incorporate Google Maps with 

Terrain or Satellite view options. This requires an internet connection, if one is not available 
then the display reverts to the normal graphical display. 

5. Changes Analyse screen view printouts to resemble the screen display 
6. Improvements to the Analyser Print functions to increase quality and functionality 
7. It has been found that the current version of Google Earth Version 7.0 has significant bugs in 

it and a trap has been incorporated into the program to detect this version and advice on a 
solution 

8. Fix a problem with the Time Server when synchronising the PC time in the GeoTagging 
screen 

9. Updated version to support Windows 8 
10. Added additional models to model list 
11. Addition of Smooth Line feature to analyse screen and performance improvements when 

updating display 
12. Animation screen to imperial or metric data as selected. 

Version 5.4.0 Consolidation of latest changes and updates 

1. This version sees the consolidation of the latest changes and updates 
2. The animation screen has be changed to reflect either imperial or metric instead of a mixture 

of both 
3. A drag and drop feature of the main screen added to open files dropped onto it 
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4. Performance increase on the analyse screen 
5. Fixed an error in the update notification screen where some useres were not being notified of 

updates 

Version 5.4.1 Consolidation of latest changes and updates 

1. Register your GTrek from the Help menu on the main screen 
2. Minor incompatibility fixes for Windows 8 

Version 5.4.2 Consolidation of latest changes and updates 

1. Error fixed in running the program when double clicking on a .GBF or .GSF file 
2. Change in the way inclination is calculated 
3. Changes to increase the redraw speed of the analyse views 

Version 5.4.3 Consolidation of latest changes and updates 

1. Change in the way the data is exported to the GTrek servers to reflect changes in the way 
Google Maps accepts external filenames. 

Version 5.5.0 Additional features 

1. A new KMZ export feature added which provides route, data points and speed profile 
2. Added feature to change the trace colours on the analyser screen 
3. added display of device serial number in the Trip Details page 

Version 5.5.5 Modification due to changes in latest version of Google Earth and updates for Windows 
10 

1. The installation of later versions of Google Earth changed the name of the executable from 
"google Earth.exe" to "Googleearth.exe" and the GTrek program was not able to open GE 
from the analyser screen.  

2. Changes incorporated due to requirements of Windows 10  
3. Incorporate the new GTrek-GeoTagger access from the main application 

Version 5.5.10 minor bug fixes and feature enhancements 

1. Mods to GTrek configuration to allow 5hz/1hz maximum logging rate selection 
2. Changes to some windows to allow for high DPI screens 
3. Java script error in onion.js on Google Maps display. This is due to updates in Google maps 

and not being copied through to Microsoft Windows. Google Maps assumes an minimum 
version of IE that Windows does not probate into embedded views. 

4. An ability to select trace colours for local display and for Google Map/Earth display to be 
stored with the trace file and not set globally. 

Version 5.5.15 minor bug fixes and feature enhancements 

1. The Java Script error with onion.js occurred again 
2. Program changes to accommodate the release of GTrek III 

 

Version 5.5.17 minor bug fixes and feature enhancements 

1. Alterations for GTrek-III compatibility 
2. Bug fix when importing GPX files 

 
Version 6.0.0 Addition of multiple segments detection on data download 
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1. New for version 6, when data is downloaded from the GTrek it is analysed for a single 
continuous stream for consists of several distinct segments. 

2. Add help menu item to QuickStats screen 
3. Add function buttons to Main screen and Analyser Screen 
4. Fix error showing lateral and longitudinal G forces on speed dispay (GTrek-Track only) 
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2. Quick Start Tutorial 

2.1 GTrek guide for Dummies 

There are a few things that need to be done before you can view any data. The major sections don't 
need to be carried out in the order below but they do need to be done. The list is not so much an 
instruction sheet, more of a list of bullet points and links to where more information can be found. 

1. Install the software  
1. Open the package and scan down the installation instruction sheet. If your version of 

Microsoft Windows is not the same as the installation instructions enclosed in the 
package then there are other versions on the installation CD. 

2. Insert the disk into your PC  
3. Install the software and device drivers  
4. Fit battery, connect to your PC and switch on your GTrek  
5. Device configuration (automatic) 

2. Charge the battery  
1. Go out and record some data. 

3. Download the data from your GTrek  
1. Trim the data stream, there is always more data (unless your very careful) than is 

useful and informative. This data is collected by your GTrek after it's been switched 
on but before your journey starts and after it's finished but before you switch it off. 
Use the Trim function here.  

2. Inspect the data, view the altitude and speed.  
3. Export to Google Earth Tour or Google Earth.  
4. Save your data for future use. 

This by no means an exhausted list of functions. Explore the program. If you have any queries, 
comment or suggestions then let us know support@gtrek.co.uk and we'll try and help. 

Program Map 
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The program when executed starts at the Home Screen and program flow is in the direction of the 
arrows. Run the GTrek application and Open an existing route file and the Analyse screen will open, 
click on the Google Earth icon and the data is exported to Google Earth. 

GTrek Track (shown here in red) is only available in the GTrek-Track version of the program. 
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3. GTrek II 

Home screen 

Thank you for purchasing and using this GTrek product. This product has 
been created to enhance your skiing experience. In fact your GTrek can 
be used to record any journey, not just skiing and reproduce an accurate 
map of wherever you have taken it (Please note item 2 in section 1 ). 

This software has been produced to be as simple and intuitive as 
possible. If you find any part confusing or would like a feature that is not 
available then let us know, we might think it's a good idea too. We 
endeavour to improve on the product to meet with your requirements. 

There are several ways in which saved route files *.GBF can be opened. 
For instance in the File menu select Open or select a recent file from the 
Recent list. From Windows Explorer simple dragging and dropping a file 
onto this screen is a quick way to open files. 

When the GTrek program is first run, connect you GTrek data logger and 
the software will be configured to match your device. Your serial number is 
displayed and a user name should be filled in. This message can be 
cancelled if preferred but will reappear again until data is entered here.  

  

Your GTrek serial number is a 5 digit number, should you need it again, 
is located on a label under the barcode either on the outside of the 
packaging or under the battery. 

To download stored data simply run the application, connect the GTrek 
device and switch it to the "Log" position. Two things will occur. 

1. The "Download and manage data" button will become active  
2. If there is more than 100 records stored a popup box will appear 

giving you the opportunity to download that data. It is not 
necessary to accept this prompt and if No is selected the data 
can be downloaded by clicking the "Download and Manage Data" 
button at any time. 

Once the data has been downloaded it only requires one other click for the downloaded data to 
be exported into Google Earth™ and enable you to get a 3D visualization of your trip. 

The GTrek program will automatically open the connection to your GTrek data logger, all you have to 
do is plug it in and switch it on. The Download and Data Manager button will become active when a 
connection has been confirmed. 

Menu items are as follows:- 

1. File menu options   
1. Open 

The open option allows you to open pre-saved routes. When 
selected the default GTrek folder is displayed. Select the file 
required and it will automatically be loaded and displayed.   

2. Import 
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The only selection here is to import a .GPX file. GPX is a general purpose GPS 
exchange file standard and many GPS products export data in this format, it is also 
the standard format for Memory Map. GPX format version 1.1 is the norm and 
Latitude, Longitude and altitude are expected, if speed is provided it will be imported 
also.  

3. File Splitter 
The File Splitter utility takes a downloaded route file *.GBF that spans more than a 
single day and splits it into separate files each associated with a complete day.  

4. File Merge 
The File Merge utility will take two or more .GBF files and merge them into a single 
file. This can be useful, for instance, if you have a days journey that naturally splits 
into two parts with some unwanted data in the middle. Save a copy of the original with 
only the one part visible and then save a second file with only the second part visible. 
Then merge the two parts into a single file. All non-visible data is discarded and you 
only get the useful stuff.  

5. Manual connection 
The Manual option provides the option to manually connect to GTrek data logger if 
the automatic process fails. If for example the connection is via Bluetooth then GTrek 
cannot automatically detect the connection.  

6. Recent Files 
The five recently opened files are listed here. To open simply click the item in the list   

7. Exit 
The Exit option will terminate the program. If there is new unsaved data then a 
message will be displayed and request whether or not that data should be changed. 
A message box will be displayed requiring confirmation that the program should 
terminate. 

2. View menu options   
1. Position 

Selecting Position will take you to the satellite data utility 
where detailed live information can be viewed.  

2. Quick Statistics. 
Selecting Quick Statistics will open a dialog where you can 
open several previously saved routes and it will create a table with statistics taken 
from each file. The fastest, longest etc. are also highlighted.  

3. GeoCode Pictures 
Selecting GeoCode Pictures will take you to the page where digital pictures and 
routes can be merged. 

3. Settings menu options  
1. Configure GTrek 

Your GTrek data logger can be configured in one of four 
standard configurations; either for use as a day-to-day 
collection system, for a week-to-week collection system 
or for longer periods. Your GTrek can now be configured 
to log in many configurations to meet all eventualities  

2. Update AGPS 
Opens the AGPS download utility allowing data to be downloaded to your GTrek to 
improve the time-to-first-fix(TTFF). 

3. Mullti-Route Settings 
Once data is downloaded it is analysed based on the setting here. For information see here. 

4. The colour scheme of the easy access function buttons can be changed to almost any colour 
you may desire. Click the Colour Scheme menu item to open the colour selection/edit box 

4. Help menu options  
1. Register Your GTrek 

Selecting this option will load your default 
Internet browser on the GTrek Registration page 
where your serial number will be entered 
automatically. Just enter your eMail address and 
your name. A response with access codes to the 
download page on the GTrek web site will be 
returned as soon as the data have been verified. 
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2. Contents 
Selecting the contents option will open the help system with the Contents tab 
selected.  

3. Index 
Selecting the Index option will open the help system with the Index tab selected.  

4. Search 
Selecting the Search option will open the help system with the Search tab selected.  

5. About 
Selecting the About option will display relevant data about the GTrek program. 

The Searching Status box provides connection status information 
on whether GTrek data logger is connected and switched on. 
There only 3 states as follows:-  

1. Waiting for GTrek connection 
In this condition the program is waiting for GTrek to be 
connected. If the device driver has not been installed correctly this message will be displayed 
even if GTrek is connected. If this is the case check for red (fault) or yellow (warnings) in 
Device Manager. 

2. Waiting for GTrek to power up 
When your GTrek is connected to your computer and switched on it will be detected by 
Microsoft Windows™ and reported to the program. If this message is displayed then switch 
your GTrek onto the LOG position or if connected via Bluetooth set to the NAV position. 

3. Found GTrek on COM4: 
If this message is displayed you are ready to go. The actual COM port to which your GTrek is 
connected to is displayed, it may not be COM4: 

3.1 File Splitter 

Your GTrek is capable of collecting data over long 
periods particularly if set to one of the Longest Storage 
Capability mode. This will create a single file that may 
span many days. 

The File Splitter utility will take this file and split it into 
several files which correspond to the individual dates 
found in that file. 

If the Auto-Save is ticked (default) then the names of 
the files created will be formatted as dd-mm-yyyy.gbf 
and saved in the default folder "MyDocuments\ski-log 
data files". If the Auto-Save is un-checked then the user 
will be given the opportunity to select the file name and storage location for each file. 

The original file will be renamed by adding "-split-" to the file name to prevent it from being 
overwritten. If a file to be saved already exists the user will be prompted to overwrite the file. If the file 
is overwritten then old file will be backed up first by 
renaming it *.bak. 

After the source file has been scanned a message is 
displayed indicating how many days worth of data the file 
contains. This may be more than expected. When 
connecting your GTrek to a PC to download the collected 
information additional entries may be added. These may 
have later dates than the main body of information.  
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When the process is complete a list of the files 
created is displayed 

For this utility to function correctly it is important 
that when downloading data from your GTrek the 
correct Time Zone has been selected so the data 
is saved with local time stamps. See "Set Time Zone" 

 

3.2 Manual Connect 

Your GTrek data logger automatically connects to 
your GTrek program without any intervention from the 
user. The Operating System (Windows™) is notified when 
any new USB devices are attached to the PC.  

If for any reason the operating system is not notified then the GTrek program cannot detect the device 
automatically and the manual facility can be utilized to scan for a device. If the Comm Port number is 
known then double clicking on the Comm Port Number box will allow the number to be entered.  

Clicking the Scan button will instruct GTrek to scan for a device. This option can take some time 
to check the ports registered in your PC. If a device is located then scanning will stop with the Port 
number displayed. 

Clicking Connect will open the port and close the window.  

3.3 Quick Statistics 

The Quick Statistics page provides a convenient way of comparing the activity of several days or 
several trips.  

Existing Quick Statistics files can be open in one of two ways:- 

1. By selecting Open on the home screen File menu, changing the default file type in the bottom 
right-hand corner to "Quick Stat Files (*.GSF)" and browsing to the saved location. 

2. By selecting Open form the File menu on the quick Statistics page. 

 

Select Add from the file menu and select as many Route Files as required. Additional Route Files can 
then be added later to the current list. 
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Some of the data displayed, Name and Resort for example are taken from data 
entered in the Trip Details. The remaining data is taken from the Route Summary 
information. 

From the file menu several option are available 

1. Add New Data 
Add new data from pre-saved Route Files  

2. New 
Selecting this option will close and currently selected file and remove any 
displayed data ready to create a new entry.  

3. Open 
Open a previously saved Quick Statistics compilation  

4. Save 
Save the current Quick Statistics compilation (no prompt to over-write file) 

5. SaveAs 
This option to save the data will prompt the user for a file name and location 

6. Print 
Print the displayed screen  

7. Print Preview 
Show a preview of the screen before it is printed.  

8. Export as CSV 
Export all displayed data to an Excel compatible .CSV file 

9. Recent 
Select a recent file from the file list. If a Quick Stats file is open then the new data will be 
added 

10. Exit 
This will close the utility 

From the settings menu various option are available:- 

1. Clicking Options will open the options screen, see below 
2. Clicking Show Totals will enable or disable the totals data 

displayable at the bottom of the table. 
3. Clicking Reset Columns will restore the displayed data 

columns to there default order 
4. Clicking Distance in Km will cause the displayed data to be in 

imperial or metric units. 
5. Clicking Interpolation will cause the data displayed to be re-calculated from the original data 

files, this can take from a few seconds to a few minutes. It is assumed that the original path 
has been saved with the .GBF file (some earlier versions will not have done so) and that the 
original file is still in the same location otherwise the re-calculation will fail. A message will be 
issued indication the status of the process, any failures will need to be corrected by hand by 
removing the offending line and re-adding that data. 

6. Clicking the Duration to Accumulative Time will re-asses the data in the total time column. If 
unchecked this will be the total time between the time and date of the first record to the time 
and date of the last record. If however this box is checked then the total time is the 
summation of the Down Time + Up Time + Flat Time. If however Interpolation is checked then 
it is unlikely that these two calculations will be different. 

When a .GBF file is opened the state of the data will be checked with the current checked state of this 
option and a miss-aligned status message may be issued. 

Clicking the Options menu item will provide a dialog box allowing the user to select which columns are 
to be made visible. Some of the columns are only available in the GTrek-Track version of the 
program. 
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Another option available here is the resolution the distance data is displayed 
to. Having a distance of some 100 miles displayed to 3 decimal places is a bit 
over the top. Likewise displaying a distance that is only a mile or so with no 
decimal places hides useful detail. 

Three options in this list associated with G Force are only available on the 
GTrek-Track version. 

The order of the columns can be altered by clicking and dragging the column 
header to the desired position. 

The column widths can be changed by clicking and dragging the column header border. 

Clicking in a column header box will re-sort the columns in ascending or descending order. 

The last three options in this list associated with G Force are only available on the GTrek-Track 
version. 

Rows can be deleted by right clicking the row to be removed and selecting Delete. 

3.4 GeoTagging 

GTrek provides a facility to GeoTag digital pictures where geo-location information is added to the 
picture file so that in the future you will not only be able to see the image, when it was taken but 
exactly where it was taken. The process is a simple one but to get the best results some items need 
to be set accurately. 

The GeoTagger can accept image in many formats including .JPG, .BMP, Canon raw image files CR2 
and Nikon raw image files .NEF along with several other popular formats. 

The detailed operation and help information is covered in another manual. See All Programs->GTrek-
>GTrek-GT Manual for more information. 

3.5 Configure GTrek 

Your GTrek can be set up to provide a large range of information 
only some of which is applicable for this application. The optimize 
option is designed to ensure that your GTrek is set up correctly. 
There are four standard options which are all time based from 0.2 
to 6 seconds, however your GTrek can be setup in an infinite array 
of logging variations. 

There are four standard options here as follows:- 

1. GTrek Sports Mode (5hz) 
This option is designed to collect data at a much higher 
rate of 5 readings per second. Top downhill racers can 
achieve speeds of more than 140kph. At this speed you 
will travel nearly 40m per second, 40m is a long way. This 
feature will provide much more data for these high speed 
events but will only provide about 6.4 hours of data.  

2. GTrek Best Resolution 
This option configures your GTrek for one second updates. With this setting up to 32 hours of 
continuous data can be collected for later analysis, more than enough for a day's activities.  

3. GTrek Longer Storage Capability 
This mode is designed to collect data at a slower rate of four seconds providing enough 
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storage capability for 66 hours of continuous data or 11 hours a day for 6 days. Don't forget to 
switch your GTrek off at the end of your day's activities.  

4. GTrek Longest Storage Capability 
This mode is designed to collect data at an even slower rate of six seconds providing enough 
storage capability for over 130 hours of continuous data, enough for a 14 day holiday. Don't 
forget to switch your GTrek off at the end of your day's activities.  

Clicking on the blue advanced options button in the bottom right hand corner will expand the display 
to allow access to the extra options. These settings are mutually inclusive, that is to say that if either 
is satisfied a log will be created 

1. Set Logging Period 
In addition to the four standard options above the logging interval can be set here to any 
value from 0.2 seconds to 99 seconds giving greater flexibility. 
The storage will indicate how much data can be stored with the 
selected time period. Selecting 0.0 here will disable the 
collection by time interval.  

2. Set Log by Distance 
Here your GTrek can be set log by distance travelled from 1.0 
meters to 99.9 meters. For example if this setting is set to 2.0m 
then travelling at a velocity in excess of 10m/s (36kph) will 
cause the unit to log at 5 times per second (the maximum 
logging rate) and giving a total travelled distance of 
approximately only 244km before logging stops. However setting this value and the period to 
20s when skiing will cause the GTrek to log every two meters and every 20 seconds if 
standing still. Setting this value to zero will disable logging by distance.  

3. Set Log by Speed 
Setting a value in here will instruct the GTrek to log data if the speed is above the threshold. 
Setting values in here and in the Log by Distance would be mutually exclusive as one would 
override the other. 

4. Set the maximum logging rate 
The maximum logging rate can be set here. If for instance the Set Log by Speed was set to 
30 km/h then if the speed was above this value then the GTrek would log data at the 
maximum rate. If maximum resolution was required then 5hz would be the selection but if 
distance was the main criteria then 1hz would be 
the best selection. 

Select the option required and click Save. A box will be 
displayed requiring the user to accept or reject the request. 
Selecting OK will set the option required whereupon 
the GTrek memory will be initialized ready for the new 
selection. Any data will be lost. The dialog box will 
automatically close. Selecting close or Cancel will exit with 
no changes made. 

3.6 Multiple-Route Settings 

Once data has been downloaded from the GTrek it is 
analysed to search for multiple segments. If adjacent 
records differ in time by more than the Minimum 
inactivity time set here in minutes then subsequent 
records are assumed to be a new segment. If a value of 
zero is entered here then all data will be assumed to be a 
single segment. 

Once all the segments have been quantified then 
segments with duration of less than the Minimum route 
duration shown here in seconds are hidden from the list. A segment with duration of less than 3 
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minutes can probably be ignored but if not then reduce this value. If a value of zero is entered no 
segments will be hidden.  

3.7 AGPS 

In certain conditions, Your GTrek may have difficulty 
providing reliable positions in poor signal conditions. For 
example, when surrounded by tall buildings (resulting in 
multiple paths), or when the satellite signals are weakened 
when a GPS device is used inside buildings. 

In addition, when first turned on in these conditions, your 
GTrek may not be able to download the almanac and 
ephemeris information from the GPS satellites, rendering 
them unable to function and obtain a satellite fix until a clear 
signal can be received continuously for a period in excess of 40 seconds for each satellite. 

An A-GPS (Assisted GPS) receiver such as your GTrek can address some of these problems by pre-
loading the necessary data into the GPS receiver from an assistance server. Pre-loading this 
information can reduce the time-to-first-fix (TTFF) to approximately 15 seconds. 

Selecting Update AGPS from the Settings menu opens the utility where this data can be downloaded 
from the GTrek servers and up loaded to your GTrek. 

The Query button reads the AGPS data from your GTrek and calculates the life (if any) of the data 
already downloaded which can be up to 7 days. 

The Update button starts the update procedure, an active connection to the internet is required for 
this process. 

The Exit button terminates the utility. 

Use the utility whenever your GTrek has not been used for several days. If the data is not downloaded 
you can still use your GTrek but it may take a little longer to obtain a satellite fix and even longer if 
you are on the move.  

3.8 Download 

The Download screen shows the record count and the memory used. 
The Erase Logger button when pressed will erase the data logger 
memory ready for a new session. A warning message is displayed 
requiring the user to confirm the request. This operation can take up to 
26 seconds to complete. 

Do not switch the GTrek off during this process as the internal 
memory will be corrupted. If this occurs use the Configure GTrek 
utility to re-initialize the memory. 

Your GTrek records location information and real time of day 
and date. This time is UTC time and is the same the world 
over. UTC is the same as GMT or British Winter time.  
 
To correct for any time difference between UTC time and the 
local time a popup dialogue box will be displayed requesting if 
the time zone data should be automatically corrected. The 
correct time zone information would need to be set on your PC 
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for the location where the data has been collected to use this utility. Time zone information can also 
be set in the analysis screen by selecting Settings->Set Time Zone and entering the time zone 
correction in hours and minutes from UTC or GMT. 

The Start Download button will initiate the download sequence. 
Additional information will be displayed indicating the progress 
on the data transfer and elapsed time. When the process has 
completed the Download box is removed and replaced by the 
data Analysis display. The user will be given the opportunity to 
initialize the GTrek memory. 

Special Note 
If the Data Analysis screen showing the new data is closed 
without saving the data the user is prompted to save this new 
information. If however the application terminates unexpectedly then that data can be retrieved 
manually. Once the data download has been completed a copy of the data is temporarily saved to the 
default location (normally MyDocuments\Ski-Log Data Files) with the name Auto-Save.gbf. Copy and 
paste this file and rename it for your use. 

Errors can occur when downloading data from your GTrek especially if your PC is short of memory 
(see recommended PC configuration) or many other applications are also running. In this event it is 
possible for data records to be lost, if there are only one or two then these can be ignored. Before 
clearing down the GTrek memory try again after closing other programs. 

3.8.1 Load Multiple Pages 

The GTrek collects and logs data once a satellite lock has been obtained in the manor defined in its 
configuration (see Analysis section). If the GTrek is switched off or a satellite lock is lost then no 
additional data is collected for this period. However once a lock is re-established new data is simply 
added to the end of the previous collection with an obvious gap in the date/times of the adjoining 
records. If this gap is short then it's safe to assume the two adjacent segments are a single file but if 
the gap is significant it could be assumed that these are separate and distinct tracks. 

Once the Download process is 
complete the data is analysed for 
these gaps in the data recorded. If 
no gaps are detected then a single 
file is assumed and the data is 
passed on to the Analysis screen to 
be displayed. 

If however multiple files are detected 
then an intermediate page is displayed showing the details of the groups detected. Now some of 
these files maybe so small they are not displayed at all and only significant ones are shown. See 
settings 

Selecting a line in the table and clicking Open Select or double clicking the line will transfer the data 
in that segment to the Analysis screen to be displayed. But working on the assumption there are more 
than two or three entries then more than one entry can be selected by clicking the first and 
then holding the Control key down and clicking additional lines. Clicking Open now will create a single 
display from multiple sources. 

Clicking Open ALL will open all segments in individual files. To open all data in one file click the first line, 
press and hold the Shift key and click the last line, all data will be selected, clicking Open Selected now will 
open the data as a single file. 
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Once all files have been or relevant segments have been opened and saved or discarded click Close. 

A tick will appear in the check box is that segment has been viewed. 

The setting controlling the selection behaviour can be view and adjusted by selecting Settings-

>Settings. See section 3.6 for details 

3.8.2 Clear GTrek 

Either from the completion of the data Download sequence or when 
selected from the Download dialog the user is given the option to erase 
the data stored on GTrek data logger.  

Selecting Cancel will leave the data intact and any additional data will be 
added until the memory is full at which point logging will cease. 

Selecting OK will start the memory initialization sequence. This process 
can take up to 26 seconds.  

An elapsed timer is displayed indicating process time. When the process 
completes the dialog box will be deleted automatically.   

If your GTrek battery is in an extremely discharged state it is advisable to 
charge the battery for 15 to 20 minutes before starting this process. 

4. Position 
GPS status and positional data is shown here. Latitude and longitude are shown in degrees and 
minutes to four decimal places.  

Universal Co-ordinate Time (UTC) is equivalent to GMT 
or BST -1 hour. Speed is in km/h and course is degrees 
from true North. Altitude is in meters above mean sea 
level as measured by the WGS84 standard. This 
standard determines that the earth is a pole-flattened 
(oblate) spheroid where the North/South radius is 
approximately 21Km less than the equator. 

The satellite data received provides information from 
which position can be calculated. Three good signals 
are required for a 2D Fix and four are required for a 3D 
fix. PDOP, HDOP and VDOP are indications of the 
Dilution of Positional information representing probable 
errors in the data. 

The image in the centre is of a representation of the visible sky from horizon to horizon and indicates 
the position of all visible satellites and their allocated numbers. Blue circles indicate satellites 
which are providing reliable data. The vertical bar graph below indicates the satellites signal strength. 

Reset GTrek, for GPS to work the receiver needs to have to hand detailed information on each 
satellite in view, this data is stored on your GTrek and updated during the normal course of operation. 
If your GTrek is switched on some distance away (over a 100 miles) from where it was switched off 
then this data can be inaccurate or in error. The information will eventually be updated and corrected 
but may result in incorrect GPS data being recorded. 
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The three buttons here have the following effect:- 

1. Hot, this button if pressed will instruct your GTrek to perform a hot restart using all current 
data available as if it had been woken up from a sleep condition  

2. Warm, this button if pressed will instruct your GTrek to perform a warm restart as if it had just 
been switch on.  

3. Cold, this button if pressed will instruct your GTrek to perform a cold restart, in this condition 
all stored data is deleted and no GPS data is stored until fresh data can be downloaded. 

Three check boxes here have the following effect:- 

1. Show Globe 
Unchecking this box will hide the Earth Image  

2. Show Satellites 
Unchecking this box will hide the blue and grey satellite circles  

3. Show Trails  
Checking this check box will cause the trails (if any) to be shown. 

5. Analyse 
The initial page of the Analysis screen shows the 
majority of the collected information on one page. 
If an internet connection is available then the 
actual route data will be overlaid on an image of 
the terrain. If no internet connection can be found 
then the route data will be display graphically. 

1. The actual route colour coded black for 
down, red for uphill sections and blue for 
flat sections for a graphical display or red 
for down, green for up and blue for flat for 
a terrain display. The actual display can 
be changed by selecting View->Show 
Map. 

2. The speed map  
3. The altitude map  
4. The route summary 

The Analysis screen is dynamically re-sizeable. Click and drag the right or bottom sides to expand or 
click and drag the bottom right-hand corner to expand or retract in both axis. 

If the route has been saved or a previous route opened then the filename for this route will be 
displayed. The total distance travelled is also displayed. Right clicking in the Route Summary section 
and you have the option of copying the data to the clip-board or switching the display to speed volume 
graph. 

The Analysis view is tabb'ed and clicking on the Multi-Route, Route, Altitude or Speed buttons will 
change the display accordingly. 

A displayed route can be exported to Google Earth™ simply by clicking the Google Earth™ icon 

 or the Google Earth Tour icon . 
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Results Summary 

The Result Summary display shows tabular data of the displayed route. The 
display is split into two columns on the GTrek-Bike version with only the left 
column being displayed in the GTrek-Ski version as skiers and downhill 
bikers are only concerned with the downhill sections whereas bikers and 
walkers etc are interested in the complete journey.  

The actual data calculation is slightly different also. In the GTrek-Ski version 
any uphill section are assumed to be lifts and all other section are assumed 
to be skied. As such any flat sections are added to the skied distance 
calculated. This is not the case for the GTrek-Bike or the GTrek-Track 
versions where the data is calculated for up, down and flat. 

The Duration section displays the total duration as calculated as the time between the start and finish 
of the displayed data. The data displayed under the "Time Down-Up-Flat represents in hours and 
minutes the time measured as traveling Down-Up and Flat. 

User defined information relevant to this data defined in the Trip Details can be viewed by clicking and 
dragging down the middle bar to extend downwards the route summary information. Here you can 
see that a user defined title "Ski Type" has been created with description "Rosignol" 

There are a number of options that can be accessed from the Route, Altitude or Speed screens, these 
are detailed below:- 

1. Right click menu 
Right clicking on any part of the analysis screen will bring up a floating menu  

1. Show Grids 
When this item is selected a grid is displayed. On the 
Route view a distance scale is also displayed.  

2. Show POI 
Points Of Interest can be added to the route see entering 
POI data. 

3. List POI's 
This option provides an easy way to remove any unwanted 
Points of Interest markers. A list is prepared, setting the 
checkbox will temporarily remove the POI. Clicking 
Confirm Deletion will remove the selected POI's  

4. List My Places 
When your GTrek is gathering data and if the button is 
pressed a My Place marker is placed on that record. When 
the data is downloaded and displayed on the Route 
view the My Place markers are shown as small blue circles. 
Selecting this item will create a list of the My Place markers 
which can be hidden or un-hidden by checking the check 
box.  

5. Re-Centre Map 
If the Google Maps view is on screen selecting this option will re-centre the map to the visible 
data. 

6. Rotate 
The Route display can be rotated with this option   

7. Zoom In and Zoom Out 
The Analysis view can be zoomed in or out via a number of different options :-  

1. By the options in the right click menu  
2. By the commands in the View menu item  
3. Via the keyboard "+" and "-" keys  
4. Via the wheel on a suitable mouse 
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8. Distance in Km 
Selecting this option will alter the display to show information in metric, clicking again 
will revert back to Imperial.  

9. Route Summary  
The Route Summary by default is displayed, clicking this option will turn if off and 
back on again. The route Summary can also be moved about the screen to aid 
viability. This is achieved by clicking and dragging. If the Analysis screen is printed 
and the Route Summary is being displayed then the visible box will snap to the 
nearest corner of the printed page.  

10. Filter 
This is only applicable to the Altitude and Speed displays, it is used to filter out 
positional noise on the recorded data. The default setting is off.  

11. Interpolation 
Data is normally gathered as a continuous stream however if data is missing then this 
continuous line will be broken. Imagine taking some data in a location. About 2 miles, 
switching your GTrek off and then moving to another location some 20 miles away 
and switching your GTrek back on again and gathering another 2 miles of data. The 
resulting information will show total distance of 24 miles with Interpolation switch on 
but only 4 miles with it switch off. Interpolation is switched on by default.  

12. X Axis selection 
This is only applicable to the Altitude and Speed displays. It switches the X axis scale 
between time at which the data was gathered, data record number and total distance.  

13. Setup Y axis. 
Setting up the 'Y' axis is only available on the Altitude view, The Altitude view 
normally zooms to show the extent of the data, using this option allows the Y axis to 
be reset to alternative values. 

14. Smooth Line 
When enabled (by default) it will attempt to smooth out the displayed line with a spline 
fit curve. The difference is more noticeable on route data when the sample rate is 
slower as may be used when walking 

2. File Options  
1. Open/Add Routes  

Selecting Open or Add Routes gives access to pre-saved 
routes. The default location is MyDocuments/Ski-Log Data 
Files. Select the route required and it will be displayed. GTrek-
Ski and GTrek-Bike only allow a single route to be displayed 
whereas the GTrek-Track version allows multiple routes to be 
displayed simultaneously.  

2. Save  
Save a previously open route.  

3. Save As 
Any route displayed can be saved as a .GBF file for later 
access.  

4. Save to Quick Statistics 
Selecting this option will cause the current data to be appended to an existing Quick 
Statistics database. The Quick Stats file that is top on the MRU list will be selected as 
the default file.  

5. Export 
The export option allows the displayed route to be 
saved in other formats. Eight options are available 
arranges into 3 groups. The top group save the visible 
data to file in different formats or standards. Group 2 
open other pages and insert the data into that view. 
Group 3 exports the data to a nominated file on the 
GTrek servers that can be downloaded and view on a 
wide selection of devices. 

1. As a Google Earth™ Format File  
Accessing Google Earth™ via the icon button 
will create a temporary file which is 
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subsequently deleted. Saving a Google Earth™ file through the export utility 
will allow the user to view routes in Google Earth™ without first loading the 
GTrek program. Data can be saved as either KML (standard) or KMZ 
(compressed).  

2. As a Memory Map™ Format File 
Memory Map compatible GPX files can be saved using this utility.  

3. Export to .CSV file 
This option will export all displayed route file data to an Excel compatible 
.CSV file.  

4. Export to .NMEA file 
This option will export the data to a NMEA compatible file. The records 
exported are GPGGA and GPRMC.  

5. Export to KMZ with data points 
This is similar to option 1 above except more data is exported as Google 
Earth folders that can be selected and switch on or off as desired. Click on 
the heading for more information. 

6. To Google Earth™ 
This option will create a temporary GE compatible file and export it to Google 
Earth. An internet connection is required to initially download GE images 
which are then stored in temporary files on your PC. By browsing over an 
area before you go on holiday will allow the GE images to be cached on your 
PC, enabling you to display routes later without a connection to the internet.  

7. To Google Maps™ 
For journeys that involve roads exporting the data to Google Maps may be a 
better option. The file produced is transferred as a KML file to the GTrek web 
server. Google maps™ is then loaded in a browser and pre-configured with 
the URL of the saved file. A connection to the internet is required before 
carrying out the procedure and may take a few seconds to upload the file 
over an ADSL connection. It may take many minutes over a dial-up 
connection. The URL shown on the Google Maps screen can then be 
e_mailed to friends for them to load into GM.  

8. To Google Earth Tour 
Selecting this option will open the Google Earth Tour screen. An internet 
connection is required for this utility. 

9. Google Earth file to Server 
This option will export the visible data to a file on the GTrek web servers. The 
saved file name will be used as a default, All upper case characters will be converted 
to lower case and all white spaces converted to "_" underscore. If the filename 
already exist the user will be prompted to overwrite it. 

10. Flight Related Formats 
This option contains two sub options:  

1. Export GPX file format 
This option is similar to option 2 above except unlike option 2 above 
which export data as a series of Track Points this option export data 
as a series of Way points.  

2. Export IGC file format 
This option will export the data in an 
.IGC compatible file format. This 
format is popular with the flying fraternity. 
 

6. Import 
The Import option allows additional data to be imported. 
One function is available as follows:-  

1. Import POI's 
Points Of Interest created on other Route files can 
be imported into the currently displayed Route (see 
Animation & POI). Selecting this option you will be 
prompted to select the file from which POI's are to 
be imported from. After the POI's have been 
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imported the number of items is displayed. Click OK to close this box. 
For a POI to be imported the map location on the new file needs to be within 
20m of the map location from where the POI to be imported is located.  

7. Page setup 
Allows access to the printer page setup utility  

8. Print Preview 
Allows the user to view printer page before printing  

9. Print  
Selecting this option will print the current Analysis view on 
the selected or default printer  

10. Exit 
This will close the Analysis view. If a new route has been loaded or an existing route 
changed then a message will be displayed requesting that the file be saved. The 
Analysis view is not actually deleted but just hidden until the application is closed. 
 

3. View Options  
1. Profile 

Selecting this option will open the Profile display page, 
this displays speed and altitude on the same graph.   

2. Animation & POI 
When looking at a route it can be difficult to establish the 
actual route taken. This utility will show your actual 
location at any time during your trip either manually or as 
an animated process. Access to setting and deleting 
Points of Interest are also accessible through this 
feature.  

3. GTrek-Track Utility 
This option (available only in the GTrek-Track version) 
will open the Track utility.  

4. Select Trace Data. 
This option allows, in the GTrek-Track version of the 
program only, the user to select which tracks should be 
displayed and which should not. The default track can also be selected. This function 
can also be obtained by selecting the "Traces menu item" but only one option can be 
selected at a time.  

5. Zoom In  
See Item 6 above.  

6. Zoom Out   
See Item 6 above.  

7. Distance in km 
Selecting this option will alter the display to show information in metric, clicking again 
will revert back to Imperial.  

8. Route Summary  
The Route Summary by default is displayed, 
clicking this option will turn it off and back on 
again. The route Summary can also be 
moved about the screen to aid viability. This is achieved by clicking and dragging. If 
the Analysis screen is printed and the Route Summary is being displayed then the 
viable box will snap to the nearest corner of the printed page. The Route Summary 
data can be switched between statistical information on the entire route or vertical 
speed bars.     

9. Show Position / Show Height / Show Speed 
If this option is selected then cursor located information will be displayed. The actual 
information displayed is dependent on the Analysis screen data currently being 
viewed.  

10. Show Date/Time/Distance 
This option only applicable in the Altitude and Speed views and will show the Date 
and Time at the cursor location or distance as appropriate.  
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11. Filtered Data 
The data displayed is by default not filtered. However it can be switched on or off by 
selecting this option to remove noise from the downloaded data. This option also has 
a keyboard shortcut Ctrl+F.   

12. Interpolation 
Data is normally gathered as a continuous stream however if data is missing then this 
continuous line will be broken. Imagine taking some data in a location, about 2 miles, 
switching your GTrek off and then moving to another location some 20 miles away 
and switching your GTrek back on again and gathering another 2 miles of data. The 
resulting information will show total distance of 24 miles with Interpolation switch on 
but only 4 miles with it switch off. Interpolation is switched on by default and will 
provide a continuous line and a single segment when exported to Google Earth.  

13. X Axis selection 
This is only applicable to the Altitude and Speed displays. It switches the X axis scale 
between time at which the data was gathered, data record number and total distance. 
With the Altitude display and the X axis set to distance, select show distance and the 
distance and hill or slope inclination will be displayed. 

14. Duration to Accumulative Time. 
Clicking the Duration to Accumulative Time will re-asses the data in the total time 
section of the Route Summary. If unchecked this will be the total time between the 
time and date of the first record to the time and date of the last record. If however this 
box is checked then the total time is the summation of the Down Time + Up Time + 
Flat Time. If however Interpolation is checked then it is unlikely that these two 
calculations will be different. 

15. Show Map 
The actual route path will be displayed on a simple green background but if an 
internet connection is available then it will be displayed with a terrain image backdrop. 
This can be zoomed in or out independently of the speed and altitude. It can also be 
switched to/from a satellite view. The clickable Show Map menu item will switch 
between the terrain and graphical display modes. If no internet connection is 
available this item will be greyed out. 

16. Re-Centre Map 
If the Google Maps view is on screen selecting this option will re-centre the map to the visible 
data. 

17. Smooth Line  
When enabled (by default) it will attempt to smooth out the displayed line with a spline 
fit curve. The difference is more noticeable on route data when the sample rate is 
slower as may be used when walking. 
 

4. Settings Option  
1. Trim Data Stream  

The data gathered may contain data either at the 
beginning or at the end that is not relevant to the 
trip. For example your GTrek is switched on 
when you leave your place of residence and 
then you travel by bus to the first ski lift or after 
the last ski run there is bus ride back. Selecting 
this utility will allow you to trim off data both at 
the beginning and end. Alternatively the data 
stream contains two segments that are of 
separate interest. Simply trim the end to get the 
first segment and save then wind back the end 
trim and trim from the beginning to get the 
second segment, save the data under a new 
name. 
Data trimmed in this way is not deleted it's just hidden.  

2. Delete Data Segment  
Often during a journey if a building is entered, for example lunch, the data collected 



© GTrek Ltd. 2016 Page 38 of 62 Version 6.0.1 

by the GTrek can be a bit erratic due to limited signal strength or signal reflections. 
This utility allows the user to delete records (permanently) from the data stream.  

3. Delete Inactive Data 
Data collected while motionless is deemed inactive data and can be removed 
manually with the "Trim" or "Delete Segment" utilities. The Delete Inactive data utility 
attempts to perform this function automatically. Inactive data in this sense is where 
the speed of movement is very low. Once deleted data orphans can be created, this 
utility can also remove these.  

4. Trip Details 
By selecting this option details of the trip can be entered. This data is used by the 
Profile display and then saved along with the route data.  

5. Set Time Zone 
The time recorded by GTrek is always UTC time (the same as GMT) no matter where 
you may be. To correct for the local time zone a correction value can be applied after 
downloading. However if this is not done or requires adjustment then it can be 
corrected here.  

6. Select Trace Colours 
This option allows you to select and alter the trace colours and widths for the 
graphical and Google Maps displays. 

5. Traces 
When in the GTrek-Track application multiple routes can be 
displayed simultaneously, the Trace menu allows the individual 
traces to be switched on and off by clicking the entry with the left 
mouse button. A tick in the check box indicates it is a shown trace. 
The default trace is shown in bold. To change the default trace 
Right Click on the Trace menu item and select the trace as 
required.  

6. Google Earth 

1. Google Earth   
The Google Earth™ button if pressed will load the Google 
Earth™ program and export your visible route so that it can 
be viewed on a 3D visualization. Zoom in on the individual 
runs and use the tour option to fly over the route taken. POI data entered is also 
viable.  

2. Google Earth Tour  
The Google Earth Tour button if pressed will open the GE tour screen and enable the 
virtual tour function. 
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5.1 Route 

The analysis display has many forms as follows:-  

1. Multi-Route 
The multi-Route page shows all information in 
a single place.  

2. Route 
The route display shows the total route as 
recorded. It is topographically correct and is 
orientated with north towards the top  

3. Altitude 
This display shows the vertical or height path 
and is displayed in meters above mean sea 
level.  

4. Speed 
This display shows speed information in either 
km/h or mph as selected. 

The displayed image can be zoomed in or out as 
required with the View menu option, by pressing the "+" or "-" keys on the keyboard or by use of the 
mouse wheel. 

Clicking the Route Summary option in the view menu or right click menu will show the route details, 
which include:- 

1. Vertical distance up and down  
2. Distance travelled up, level and down from which the skied distance can be determined.  
3. Average speed over the while journey and the average down speed (it's assumed that all 

skiing is skied traveling down. Skiing up hill or on the flat is not counted).  
4. Total duration of visible data   
5. The number of laps or lifts taken. Note however that if two lifts are taken consecutively without 

a downhill run then this counts as one. 

In the Settings menu the Trim facility can be selected. This gives you the option of removing extra 
data before and after the period in which you are interested. 

In the View menu can be found other useful options:- 

1. Access to the Profile view  
2. Show additional data  
3. Filtered Data selection 

5.2 Altitude 

The Altitude display will show height information of the collected data. The data here is displayed in 
feet or meters as appropriate. 

If the View->Show Height property is selected then as the cursor is moved over the display the 
detailed Altitude data is displayed. If the X axis is set to distance the inclinometer is displayed. 

Using the Zoom In and Zoom Out functions will display the data in more or less detail. 
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5.3 Velocity 

The Speed Analysis display will show speed information of the collected data. Scaled data can be 
either mph or km/h as selected.  

If the view->Show Speed property is selected then as the cursor is moved over the display the 
detailed speed data is displayed.  

Using the Zoom In and Zoom Out functions will display the data in more or less detail. 

When running the GTrek-Track version three tick boxes are visible Show Speed, Lateral G and 
Longitudinal G. Clicking the boxes will switch on and off the selected traces. The sample frequency of 
the longitudinal G force scale can also be adjusted, the default value of 10 should give good results. A 
value to high will hide detail whereas a value to low could show data erroneously.  

Lateral G forces are experienced when cornering at speed. Clockwise rotation is shown above the 
centre line and anti-clockwise rotation is shown below the centre line. 

Longitudinal G forces are experienced when accelerating and decelerating. Acceleration creates 
positive G and deceleration creates negative G. 
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5.4 Profile Display 

The Profile Display shows the Altitude 
and Speed information on the same graph. 

Useful and informative information is displayed along with 
data entered on the Trip Details section. The background 
picture can also be changed on the Trip Details to one of 
your own. 

File Menu 

1. Print 
This will initiate the print command  

2. Print Preview 
This will initiate the Print Preview Command  

3. Exit 
This will exit the utility 

Settings Menu 

1. Show Altitude 
This will switch on and off the altitude profile.  

2. Show Speed 
This will switch on and off the Speed profile.  

3. Show Filled. 
Selecting this option will cause the profile to be drawn filled.  

4. Show Lines 
This option will switch on and off horizontal line for speed and altitude 
if displayed  

5. Show Speed On Top  
When viewing the Filled mode either the speed or altitude may be obscured this option will 
change the drawing order.  

6. Options 
See below.  
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7. Set Transparency 
Setting this option will display the transparency slider in the top 
right corner of the display 

The Profile Options screen 

The profile options screen allows the user to select, if any, which 
information is displayed in the top two boxes of the profile screen. 
Items selected in green are displayed in the left box whereas items 
show in pink are shown in the right box. 

The Reset Order button will reset all selections. 

Left clicking and any box will select that box to as a green box, right 
clicking in any box will select that box as a pink box. Clicking the 
last entered box will clear that selection allowing the selected list to 
be un-wound 

5.5 Rotate Displayed Route 

The Route display can be rotated by selecting the Rotate option from the Right Click menu.  

Either use the slider to rotate the display or enter the required angle in the test box and click Apply. 
North is assumed to be 0 degrees and the map rotates clockwise through 360 degrees. 

If the Route Rotation angle is saved in the .GBF route file, if the angle is changed then the route file 
will expect to be updated and the user will be prompted to do so when the Analysis screen in closed. 

 

5.6 Route Summary 

The Route Summary function is normally enabled and can be disabled if 
required. The Route Summary box can be moved to other parts of the 
screen if it is found to be covering important detail by clicking and 
dragging the box to another location. The Ski/Bike/Track version display 
different information, the Ski version mainly displays downhill data only 
whereas the Bike and Track versions have a more balanced approach. 
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There are two options for the Route Summary screen 

1. Statistical route data 

The display can be changed to Km by selecting "Display in Km" from the View Menu.  

The information displayed: 

1. Vertical Ascent 
Vertical ascent is the distance travelled vertically up.  

2. Vertical Descent 
Vertical descent is the distance travelled vertically down.  

3. Up Distance 
The up distance is the calculated distance traveling in the up direction, lifts 
etc. An average gradient greater than 1:20 is used for the calculation. The 
actual distance is calculated from the horizontal plain and corrected for the 
angle of ascent.   

4. Down Distance 
The down distance is the calculated distance traveling in the down 
direction, skiing (probably). An average gradient greater than 1:20 is used for 
the calculation. The actual distance is calculated from the horizontal plain and 
corrected for the angle of descent.   

5. Level Distance 
The level distance is where movement is detected but no apparent change in 
altitude can be observed.  

6. Average Speed 
The average speed is calculated from the total distance covered over the 
total period.  

7. Average Down Speed. 
The Average down speed is calculated from the Down Distance (4 above) 
and the total time traveling down. All lifts are removed along with and 
movement deemed as level or not moving at all.   

8. Maximum Speed 
The maximum speed detected over the period is recorded here. To find 
exactly where this point is on the route select the point in the Speed display 
with the Animation & POI function and create a Point Of Interest, label it Top 
Speed and then view it on the route display.  

9. Event Duration 
The event duration is recorded from the date and time of the first displayable 
record and the last displayable record and is shown here as hh:mm:ss or if 
the period is more than 24 hours as d.hh:mm:ss.  

10. Lap Count 
Laps are calculated based on a measured change in altitude, if the change 
is more than 50 meters then a new lap is assumed. 

The contents of the Route Summary can be copied 
to the clipboard by right clicking in the box and 
selecting Copy. 

2. Vertical bar graph of Speed  
 
The data displayed here shows the distribution of the speed 
data recorded. The peak shown here indicates that the user 
travelled at 9.3 mph for 18% of the time. 
 
The total route data is broken down into 50 equal speed 
segments. The speed data is then analysed each speed 
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value is counted. ie if there was 10,000 records and the speed was measured at 10mph 1,000 
times then the 10mph bar would represent 10% of the total.  

5.7 Google Earth file with data points 

This option when selected will export the currently 
displayed route file data to a Google Earth compatible .KMZ 
file that can be displayed in Google Earth independently of 
the GTrek program and is thus ideal for sharing with others. 
 
It provides data in the form of folders or layers when opened 
in Google Earth, these files can be large and can take a few 
seconds to open in Google Earth. Clicking on the open 
pointers will open a level and clicking on the close pointers

will close a level. 
 
SpeedBar 
The SpeedBar is used in conjunction with the Speed Track 
(see below). Clicking the tick box here will display or hide the 
Speed Bar image. Speed values here indicated either km/h or mph as selected on the Analyse 
screen. 
 
Track 
Clicking the tick box here will display or hide the entire track displayed here 
as a single track in a single colour. 
 
Track Point 
Clicking this check box will display 
or hide all the individual data 
points with date and time being 
displayed on the map. Huge 
amounts of data can be displayed here and unless zoomed in close data 
can be difficult to see. Opening this folder will display all the data points 
which can be switch on or off individually as seen here. 
 
Track Point (No text) 
Clicking this check box will display or hide all 
the individual data points however no data is 
displayed on the map only clickable data points 
or icons. By default the first  and last  points 
are displayed. 
 
Speed Track (Km/h) 
Enabling this check box will display the track 
as a speed track, colours indicating the 
speed as shown on the Speed Bar. Speed is 
calibrated in mph or km/h as selected on the 
Analyse screen. The Track display (see 
above) need to be switch off to see this data 
 

Journey Posts 
Enabling this check box will display the Journey Posts in mile or km increments. 
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5.8 Google Earth Tours 

When the Google Earth® Tour  button is clicked a message is displayed 
requesting the "smoothing value". The default value for Google Earth is 1 but 
you may wish to increase this value. It controls the granularity of the data. A 
higher value will result in less data, a lower value will result in more data with 
better resolution. However when exporting data to Google Earth Tour with a 
smoothing value of 1 will require more computer memory, In fact it can take 
large amount of computer memory 

Select Track on ground for earth based routes where altitude data is 
ignored or Track not on ground for airborne tracks. For the airborne option 
an altitude correction can be entered if required.  

It has been noticed that some Google Earth images are not as accurately 
placed as one may expect. If you experience this it can be corrected here. 
Measure the error in Google Earth with the Measure tool, export your data again but this time with the 
corrections. The alterations are measured in meters, a positive correction will move the trace in a 
northerly or westerly direction. 

The technology being used here is based on web 
browser technology provided by Internet Explorer and 
the data has to be loaded into it, this can take from a 
few seconds to a few tens of seconds and a progress 
bar is provided. If this process it protracted then an error 
box such as this one may be displayed, if you click No 
then the process will continue to load the requested 
data. This is not an error, it's just taking a long time. 

The page will open and attempt to load the Google 
Earth application, a connection to the internet is 
required for this. On the first application if the necessary Google Plug-in is not already loaded you will 
be presented with an option to download and install the required extensions click accept. Once loaded 
it will be necessary to close the page and re-enter again. 
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Information provided by the Tour Status is dynamically updated as the tour progresses:- 

1. Progress - shows how far through the tour you are. On the right hand side of this control are 
two buttons that allow you to step forward or backward. 

2. Speed - actual instantaneous speed. 
3. Altitude - instantaneous altitude. 
4. Date/Time - instantaneous Date and Time. If this data is incorrect it may be due to an 

incorrectly set time-zone. See Settings->Set Time Zone on the analyser screen. 

The display will automatically zoom down to the location on the globe where the route was recorded. 
Uphill sections are shown in red and downhill in green. 

Navigation controls 

1. Click and drag the left mouse button to pan the visible image.  
2. Double left clip to zoom on a point.  
3. Click and drag the right mouse button to control rotation and zoom.  
4. Double right click to zoom out.  
5. Left shift + left mouse button control rotation and tilt angle 

The options section control visible data such as the status bar and navigation controls.  

The Layers section control visible layers such as Terrain (3D), Buildings (3D), roads and borders but 
the Look At or Camera requires a bit of an explanation (see below). 

Whenever the tour is not running clicking the Take Picture button with record a snap shot of the 
image and save it to your hard disk. 

To start the tour:- 

1. First select your chosen model from the list, be it a skier, a border, a car or a bike.  
2. Click Reset Tour, this will reset all the internal systems and zoom down to the start point of 

the loaded data. Your selected model will also now be visible. If it's not the right one just 
select another, selecting a yacht to sail up a mountain only looks a bit odd. Everything is 
possible here.  

3. Click Start Tour and enjoy the ride. 

A couple of things need mentioning here, this tour is in real time, that is if the recorded data took 7 
hours then the tour will take 7 hours and I know you've got a very low attention threshold !!. So take a 
look at the Faster Up Hill check box, if this it ticked then the speed uphill is increased by 10 times. 
The Speed Factor controls the total speed from 0.1 (1/10th) to 30 times normal speed. So a 7 hour 
tour will take only 14 minutes. 

The chart on the right can be set to display speed, altitude or lateral G force. 

If you have started the tour you will have noticed that the view of the model doesn't change much it's 
the view of the landscapes that's moving. You are always looking at the model. Well that makes 
sense, that's supposed to be you. The Viewing controls adjust this view point and are detailed below 

1. Altitude 
Controls the up or down viewing position from -100 to + 100 meters. Please bear in mind that 
the viewing position can't be such that it would be below ground.  

2. Range 
Controls the view distance from the model.  
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3. Tilt 
Controls the angle of the view. 90 is a horizontal view point and 0 is straight down. See the 
Look At or Camera description below.  

4. Rotation 
The view point can be rotated around the model from -180 degrees to +180 degrees.  

5. Speed Factor 
A Speed Factor of 1.0 is real time, this can be set to 0.1 (1/10th) to 30 time full speed.  

6. Fixed View 
The view point is to normally follow the object from a fixed point, if the Rotation is set to zero 
then this is from behind. If the Fixed View is ticked then the viewing angle is from a fixed 
angle and if the model rotates the viewpoint will be from the same place.  

7. Scale 
If the range is extended outwards to show more background the model can disappear into the 
landscape. The scale control will increase the size of the model to increase it's visibility. 

Look At or Camera 

In the Google Earth Tour there are two ways in which a view can be created as follows:- 

1. Look At 
The Look At object is a light weight control, that is to say it requires less processing power to 
make it happen but it has some limitations: 
1)  The tilt angle can't be any more than 90, you can't look up at a model. 
2)  The look At point is always the model and you can't look away. 
3)  You can't set the view point in front of the model ie a negative range.  

2. Camera 
The Camera object requires more processing power but has the advantage: 
1) The tilt angle can be greater than 90 degrees so you can look up at a model. 
2) The camera can be rotated away from the model. 
3) You can set the view point in front of the model. 

5.9 Google Earth 

When the Google Earth® button  is clicked or Google Maps is selected a 
message is displayed requesting the "smoothing value". The default value for 
Google Earth is 4 and for Google Maps is 1. It controls the granularity of the 
data. A higher value will result in less data, a lower value will result in more data 
with better resolution. However when exporting data to Google Earth with a 
smoothing value of 1, if there is a large record count, it may cause the tours to 
be less than smooth unless you have a very high performance PC and graphics 
card to match. This is not a limitation of GTrek but of your PC. Google Maps 
can't handle large quantities of data points. The actual number depends on 
what other data is included but 30,000 points should be a rough rule.  

Select Track on ground for earth based routes or Track not on ground for 
airborne tracks.  

It has been noticed that some Google Earth images are not as accurately placed as one may expect. 
If you experience this it can be corrected here. Measure the error in Google Earth with the Measure 
tool, export your data again but this time with the corrections. The alterations are measured in meters, 
a positive correction will move the trace in a northerly or westerly direction. 

The Export Data Types is only displayed when exporting to Google Earth from the GTrek-Track 
application. Export Standard route is the normal option. Selecting Export Smart Route will create 
an extra data folder when viewed in Google Earth. See below. 
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The Google Earth program will be started 
automatically. A copy of the displayed data points 
will then be exported into the program and 
displayed.  

Returning to the GTrek program and loading another 
route which is then sent to Google Earth™ (which is 
still running) will display both tracks simultaneously. 
This can then be repeated as required. 

Google Earth provides extensive help files and 
tutorials accessible form the Help Menu. 

To use the Tour function double click on the path 

Segment and click the run button to start the tour. 

      

Use the Play control panel to control the 
animation. 
 

Tour options can be accessed from the Tools->options menu. Select the Tour tab and select the 
options required, an example is below. 
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If problems are experienced displaying GTrek data in Google Earth or no data is displayed at 
all, Select Tools->Options and in the 3D View tab try changing the Display Mode from either OpenGL 
or DirectX to the other selection, close GE and re-open. 

Ensure you have the latest graphics drivers as GE uses all 
the features they have to offer. 

One condition that has been brought to our attention is that 
if your PC is configure to use a "," for a decimal data 
separator instead of a "." then Google Earth can get very 
confused. Changes have been made to the export function 
to prevent this but if the problem persists then you can 
change this option by selecting Regional and Language 
Options in Control Panel. If problems are encountered with 
erratic plots then try this. 

If the "Export Smart Route" is selected then extra data will 
be loaded into Google Earth and screen similar to the one shown here will be displayed. An overview 
of the route is also shown in the top left hand corner. 

In the Layers section, deselect the Terrain option (due to 
problem with GE). Highlight Smart Tour 1 and click the play 
button. 

Caution - Google Earth then processes the information 
presented to it. This can take a while so be patient. The results 
are worth waiting for. 

Unticking the Support files box will turn off the overlaid images. 

5.10 Export Google Earth file to GTrek Servers 

The Export Google Earth file to Server option will format the visible data into a single file and upload 
the data to the GTrek servers with a file name selected by the user. This file can then be accessed by 
the community on a variety of devices including other PC's MAC's and the majority of the available 
smart phones. If the filename already exists a prompt to overwrite will be provided, the existing file 
may belong to another user and you are about to overwrite it. 

When selected a pop-up box will be displayed requesting a file name, if the route has already been 
saved then that name will be displayed as default. Any spaces in the file name will have been 
replaced with "_" (underscore) characters and this is 
recommended, all uppercase characters are also converted to 
lowercase. 

The data can be exported in either of 2 formats:- 

1. As a KML file 
This a raw data format and is compatible with all versions 
of Google Earth and Google Earth for mobiles. 

2. As a KMZ file 
This is a compressed file format and results in a much 
small file size which will upload and download much 
quicker but at the time of writing Google Earth for Mobiles 
supported by Apple on IOS 4 and Android V2.x do not support this file format and the KML 
type should be used. 
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The filename entered needs to be unique and selecting a simple common name may result in another 
user overwriting your data so careful selection here is important. Click OK to accept the file name, 
select any options required on the "Google Earth Export Settings" and click OK. The data will be 
uploaded, this can take from a few seconds to a few tens of seconds, be patient. 

Once uploaded, a message will be displayed 
giving you the URL of your file. Two options are 
provided as follows:- 

1. For Google Earth 
For this option click Copy to Clipboard 
and paste into the Address Bar of your 
Internet Browser and select open in 
Google Earth. For this option Google 
Earth needs to have been installed on the PC being used. 
 

2. For Google Maps 
For this option click Copy to Clipboard and paste into the Address Bar of your Internet 
Browser. This option it totally internet based and does not need anything to be installed prior 
to viewing the data. 

For Smart Devices open the internet browser and enter the URL in the address bar, when 
downloaded select open in Google Earth. For Apple devices you may need to download Google Earth 
from the app store first. 

The data will remain on the GTrek servers for about a month after which it will be removed. Should 
you need a longer period please let us know. 

5.11 Trim Data Stream 

The data collected can include information 
that is either not relevant or is not desired. 
For this purpose data can be trimmed 
from the beginning and from the end of 
the displayed data stream.  

Moving the sliders will remove or replace 
displayed data from the current image. The slider can be dragged with the cursor or moved with the 
arrow keys once selected for fine adjustment, the "+" and "-" for small movement and page-up and 
page-down for course movement. 

Clicking and dragging the slides will only update the display when the mouse button is released. The 
Auto Update if ticked will cause the display to update whenever a key that effects the sliders is 
pressed, this can be a bit slow so if this check box is un-ticked the display only updates when the 
update display button is clicked. 

Time, date, altitude and speed information from the record is displayed to assist in the selection.Data 
trimmed in this way is not actually deleted but hidden and can be retrieved at any time later. 

If data is altered in this way saving the route to a file will retain the selections made. 

Click Accept to accept changes or cancel to reject. Clicking Reset to Defaults will move the sliders to 
the extreme ends displaying all data. 
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5.12 Delete Data Segment 

Often during a journey when a building is entered, for example for lunch, the data 
collected by the GTrek can be a bit erratic due to limited signal strength and/or 
signal reflections. This utility allows the user to delete records (permanently) from 
the data stream.  

This facility can be selected from the Multi-Route, Route, Altitude or Speed 
displays and a selection screen with two sliders will be displayed. 

Normally the display will automatically update when the sliders are moved. This 
can create an enormous amount of re-processing the data. If the Auto Update 
check box is unchecked then display updates are only carried out when the 
Update Display button is pressed. 

The sliders can be moved with the mouse pointer just click and drag or with the 
keyboard keys left and right arrow, "+" and "-" or PageUP and PageDown change 
the counter by 1, 10 or 100 respectively of the currently selected slider. 

The selected segment to be deleted is highlighted as can be seen here. 

Clicking Delete Segment will permanently remove the data. It is advised that a backup copy of the 
data be taken first. 

5.13 Delete Inactive Data 

The "Delete Inactive Data" utility attempts to delete unwanted data 
automatically by identifying all data records where the recorded speed is 
less than a selected limit. 

The Selectivity controls the minimum speed and Consecutive Segments 
controls how many records need to be within the limits to be accepted. The 
records selected for deletion are shown in green on this speed map below. 
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Once the Delete Inactive Data button has been clicked orphaned segments can be created as shown 
below. 

 

Moving the "Orphan Size" slider will accept bigger or small orphans. Setting this to big may cause 
wanted data too be removed. Clicking "Delete Orphans" will remove the data. 

The "Undo Changes" button will restore all data if too much has been removed. 

5.14 Animation & POI 

When viewing a complex route it can be difficult to 
determine the actual route taken.  

This animate feature if selected will display an icon on the 
route at any time selected or the route can be played out 
automatically by clicking Run Animation. The Speed slider 
controls the speed on the animation. 

 

To save a Point Of Interest (POI) move the slider to the required position, in this example the speed 
screen is displayed and the slider has been moved to point at which maximum speed has been 
measured. 
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Clicking on the Save POI will bring up a text entry box, type in here the text for the POI. 

The POI is then displayed and can be viewed on the Route, Altitude, Speed and Profile displays when 
enabled. 

               

To delete a POI move the Animation slider back to the same position, 
the Save POI button changes to Delete POI, clicking this button will 
delete the entry.  

As many POI's can be entered as required. The information shown here 
was provided by Matthew and is also provided in this installation, open 
file Whistler.gbf which can be located in MyDocuments/ski-log data 
files/Samples folder. 

My Places (MP) markers are created by pressing the button the your 
GTrek data logger and are shown on the Route display as small circles. 
These markers can be hidden or un-hidden by moving the slider to the 
location on the route and clicking Hide MP. Another way to do this is via 
the List MP facility in the right click menu. 

5.15 Trip Details 

Default Data 

The Trip Details facility allows the user to enter personal information 
regarding the Route data. Some of the information entered is displayed 
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on the Profile Display page and on the Quick Statistics page.  

The Profile Picture entry allows the user to select the 
background picture used on the Profile. 

The File Name and Duration data are entered automatically, 
the latter being taken from the Route Summary data. 

Optional Extended Data 

Data entered here is displayed on the Route summary if 
enabled, if not enabled the fields are greyed out. This data 
field if free form and allows both title and description to be 
entered.  

If information can be saved as a profile and restored at a later time by selecting 
Save or Restore from the File menu. 

5.16 Select Trace Colours 

Traces are split into three categories: Up, Down and 
Flat and are indicated on the Route maps by different 
colours. This utility will allow you to change the route 
trace colours.  

Route maps are displayed overlaid on a Google 
Maps image if an internet connection is available 
or as a graphically display on a green background if 
not. The colours and line widths for each can be 
changed. The changes are global and not stored with the route (.GBF) file. 

Clicking the Reset Defaults button will return all colours and line widths to the 
default value. 

Click on any of the colours will open the colour picker and any of the 40 Basic or 16 Custom colours 
can be selected. "Clicking Define Custom Colours >>" button will open the extended colour selection 
option where the number of colours available is only limited by your computer graphics system. 

5.17 GTrek-Track Utility 

This feature is only available on the GTrek-Track version 

To extract track data follow the following steps:- 

1. Download the data from your GTrek and trim off or delete and extra information not applicable 
(fig 1 & 2).  

2. Select the GTrek-Track utility from the View menu (fig 3).  
3. Move the Set point slider to a position on the route from where data will be collected from (fig 

3). With this setting only data will be extracted from the start point to the same location. This 
process will be repeated until no data is left. Alternately if the Set Stop Position is enabled the 
data collected will be between the start and the stop location, all other data will be ignored.   

4. If the line created is not at the angle required then it can be rotated with the control knob. 
5. Clicking the Extract Data button will start the Track analysis process 
6. Two new screens will be created, a new route screen with the new extracted traces and a 

Quick Statistics screen (figs 4 & 5).  



© GTrek Ltd. 2016 Page 55 of 62 Version 6.0.1 

7. Fig 6 shows the results from just on circuit. 
 

Fig 1 Fig 2 

 
Fig 3 Fig 4 

Fig 5 
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Fig 6 

5.18 Select Trace Data 

Within the GTrek-Track version of the program multiple 
routes or traces can be displayed simultaneously. These 
can be added manually or can be created with the GTrek-
Track utility. These traces can be switched on or off by 
selecting them via the Trace menu item but only one at a 
time. 

This utility overcomes this limitation by displaying all traces 
at once. Clicking in the trace column for any trace will 
select that trace to be the default trace. Clicking in the 
Visible column will switch that trace either on or off. 

Select All or Select None will switch all traces on or off. 

6. Support 
Your GTrek GPS data logger and the GTrek program have been rigorously 
tested by system designers and users alike and all known bugs and problems 
have been dealt with.  

However in the unlikely event of you finding a problem we would, in the first 
instance, request that you check out the FAQ page on the website 
www.gtrek.co.uk . Secondly send an e-mail to support@gtrek.co.uk 
describing the problem, including the following information 

1. Operating System (XP, Win200, Vista, Windows 7 etc) (see 
General tab in System Properties)  

2. Computer type (Intel or AMD), speed and memory  
3. Video card type  
4. If your problem is relating to a connection difficulty then when 
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your GTrek is connected to your PC can you see an entry in Ports (COM & LPT) section of 
the Device Manager ? (see picture)  

5. Is your problem with the GTrek installation or the GTrek program or your GTrek device ?. 

We are always striving to improve the GTrek product. If you find any aspect difficult to understand or 
there is a feature you consider would be useful then please let us know. Send an e-mail to 
support@gtrek.co.uk and we will give all comments serious consideration 

Register your GTrek via www.gtrek.co.uk and we will 
keep you informed of program updates or just check the 
update page periodically. We will not share your data 
with third parties unless they are directly connected with 
the product. 

If the device driver has been installed correctly then an 
entry in the Ports section of the Device Manager such as 
the GPS one shown here or "LOCOSYS Technology GPS Receiver" may be displayed instead. This 
will only be shown when the GTrek is connected and switch on. 
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Appendix 

Appendix A – Specifications 
General 
Frequency L1,1575.42MHZ 
C/A Code 1.023MHZ 
Datum WGS84 

Performance Characteristics 
Position Accuracy Without aid: 3.0m 2D-RMS (worst case 15.0m) 
 <3m CEP(50%) without SA(horizontal) 
 DGPS (WAAS,EGNOS,MSAS,RTCM):2.5m 
Velocity Accuracy Without aid: 0.1m/s 
 DGPS (WAAS,EGNOS,MSAS,RTCM):0.05m/s 
Acceleration Without aid:<4g 
 DGPS (WAAS,EGNOS,MSAS,RTCM):<4g 
Timing Accuracy 50ns RMS 
Re-acquisition Time <1s 
Hot start 1s (Typical) 
Warm start 33s (min), 15s with AGPS 
Cold start 36s (min) 
Sensitivity Acquisition:-158dbm 
 Tracking:-165dbm 
Update 0.2s, 1s, 4s, 6s or variable 0.2 to 99 seconds 

Dynamic 
Altitude Maximum 18,000m 
Velocity Maximum 515m/s 
Acceleration Maximum 4g 

Power 
Input Voltage Vin : 5.0V±10% 
Power Consumption 40mA max. 
Battery Built-in rechargeable 1000mAH Li-ion battery 

I/O 
Available Baud Rates 115,200 bps 
Protocols NMEA 0183 v3.01 

Environment 
Operating Temp. -10 ~ 60˚C 
Storage Temperature -20 ~ 60˚C 
Charging 0 ~ 45˚C 

Bluetooth 
Standard Fully compliant with Bluetooth V1.2 
Output Power 0dbm (Typical),Class II 
Range Up to 15 meters 
Bluetooth Profile Serial Port Profile (SPP) 
Frequency 2.4G ~ 2.4835GHz ISM Band 
Security Yes 

USB Bridge 
Standard Fully compliant with USB 2.0 
Full - speed 12Mbps 

Dimension 
GTrek 46.5 x72.2 x20 mm 
Weight 60g (including battery) 

Data Log 
16Mb serial Flash ROM 
Up to 125,000 way points (typically 123,000) (GTrek-II), Up to 250,000 way points (typically 246,000) (GTrek-III) 
Log GPS data by time interval 
Log GPS data by button push. 
User can configure settings by using utility. 
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Appendix B – Certification 

FCC Notices 
 
This device complies with part 15 of the FCC rules. Operation is subject 
to the following two conditions: 

1. This device may not cause harmful interface, and 
2. This device must accept any interference received, including 

interference that may cause undesired operation.  
 
FCC RF Exposure requirements: 
This device and its antenna(s) must not be co-located or operated in 
conjunction with any other antenna or transmitter. 
 
NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY 
RADIO OR TV INTERFERENCE CAUSED BY UNAUTHOURIZED 
MODIFICATION TO THIS EQUIPMENT. SUCH MODIFICATIONS 
COULD VOID THE USER’S AUTHORITY TO OPERATE THE 
EQUIPMENT. 
 
Industry Canada Caution 
 
The installer of this radio equipment must ensure that the antenna is 
located or pointed such that it does not emit RF field in excess of Health Canada 
limits for the general population; consult Safety Code 6, obtainable from Health 
Canada's website. 
 
"www.hc-sc.gc.ca/rab" 
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CE Notices 
 

 
 
Is herewith confirmed to comply with the requirements set out in the 
Council Directive on the Approximation of the Laws of the Member 
States relating to Electromagnetic Compatibility (89/336/EEC), 
Low-voltage Directive (73/23/EEC) and the Amendment Directive 
(93/68/EEC), the procedures given in European Council Directive 
99/5/EC and 89/3360EEC. 
 
The equipment was passed. The test was performed according to the 
following European standards: 
 
- EN 300 328-2 V.1.2.1 (2001-08) 
- EN 301 489-1 V.1.4.1 (2002-04) / EN 301 489-17 V.1.2.1 (2002-04) 
- EN 50371: 2002 
- EN 60950: 2000 
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Appendix C – Warranty Information 

Thank you for purchasing the GTrek product. 
 
The company warrants this product to be free from defects in materials and 
workmanship for one year from the date of purchase. The warranty for 
accessories is also 12 months. The stamp of distributor or a copy of the original 
sales receipt is required as the proof of purchase for warranty repairs. The 
company will, as its sole option, repair or replace any components, which fail in 
normal use. Such repair or replacement will be made at no charge to the 
customer for parts or labour. The customer is, however, responsible for any 
transportation costs.  
 
This warranty does not cover failures due to abuse, misuse, accident or 
unauthorized alteration or repairs. The company assumes no responsibility for 
special, incidental punitive or consequential damages, or loss of use. 

 

 

 

 

  


